MCITP: Supporting and Troubleshooting Applications on a Windows Vista® Client for Enterprise Support Technicians

Exam 70-622

Paul A. Mancuso
David R. Miller
Introduction

Welcome to the 70-622 Exam Cram! Whether this book is your first or 15th Exam Cram series book, you’ll find information here to help ensure your success as you pursue knowledge, experience, and certification.

This book aims to help you get ready to take and pass the 70-622 exam. After you pass this exam, along with the 70-620 exam, you will earn the Microsoft Certified Information Technology Professional (MCITP): Enterprise Support Technician certification.

This introduction explains Microsoft’s certification programs in general and describes how the Exam Cram series can help you prepare for Microsoft’s latest certification exams. Chapters 1 through 5 cover the information you need to know to pass the 70-622 certification exam. The two sample tests at the end of the book should give you a reasonably accurate assessment of your knowledge and, yes, we’ve provided the answers and their explanations for these sample tests. Read the book, understand the material, and you stand a very good chance of passing the real test.

Exam Cram books help you understand and appreciate the subjects and materials you need to know to pass Microsoft certification exams. Exam Cram books are aimed strictly at test preparation and review. They do not teach you everything you need to know about a subject. Instead, we streamline and highlight the pertinent information by presenting and dissecting the questions and problems we discovered that you’re likely to encounter on a Microsoft test.

Nevertheless, if you want to completely prepare yourself for any Microsoft test, we recommend that you begin by taking the self-assessment included in this book, immediately following this introduction. The self-assessment tool helps you evaluate your knowledge base against the requirements for becoming a Microsoft Certified Technology Specialist (MCTS) and is the first step in earning more advanced certifications, including the Microsoft Certified IT Professional (MCITP), Microsoft Certified Professional Developer (MCPD), and Microsoft Certified Architect (MCA).

Based on what you learn from the self-assessment, you might decide to begin your studies with classroom training or some background reading. On the other hand, you might decide to pick up and read one of the many study guides available from Microsoft or third-party vendors. We also recommend that you supplement your study program with visits to http://www.examcram.com to receive additional practice questions, get advice, and track the Windows certification programs.
This book also offers you an added bonus of accessing *Exam Cram* practice tests online. All you need is a connection to the Internet, and you can take advantage of these practice exam questions directly from your own web browser! This software simulates the Microsoft testing environment with similar types of questions that you’re likely to see on the actual Microsoft exam. We also strongly recommend that you install, configure, and play around with the Microsoft Windows Vista operating system. Nothing beats hands-on experience and familiarity when it comes to understanding the questions you’re likely to encounter on a certification test. Book learning is essential, but without a doubt, hands-on experience is the best teacher of all!

**The Value of Certification**

It is an established fact that the field of computers and networking is a fast-paced environment. Therefore, employees who work in Information Technology (IT) must learn to keep up with the ever-changing technology and have the ability to learn new technology. It is said that IT professionals must be able to learn or retrain themselves every 1 to 1½ years.

According to *Certification Magazine* (http://www.certmag.com), the successful IT worker must

- Be proficient in two or more technical specialties.
- Be able to wear multiple hats.
- Be more business-oriented because hiring managers are looking for employees who see the big picture of profit, loss, competitive advantage, and customer retention and understand that IT fits into this picture.
- Be able to work easily with nontechnical personnel.
- Have soft skills of good listening, problem solving, and effective written and verbal communication.

In addition, there is a demand for those who can demonstrate expertise in IT project management. Those moving to a mid- to high-level position will have a mix of academic credentials and industry certifications, as well as increasing levels of responsibility.

Today, technical certifications are highly valuable. Depending on which certification or certifications an individual has, they can allow that user to begin as an entry-level technician or administrator, or those certifications can demonstrate the knowledge and capabilities of a current technician or administrator. Technical
companies see some technical certifications as valuable as a college degree, and nontechnical companies see them just a little less than a college degree.

You can see that certification is

- A demonstration of specific areas of competence with particular technologies
- A credential desired or required by an increasing number of employers
- A tool people use successfully to challenge themselves
- A road map for continuing education
- A potential bridge to a new specialty
- Evidence that you are self-motivated and actively working to stay current

On the other hand, certification is not a substitute for extensive hands-on experience, and it is not a career cure-all. Lastly, being able to pass these exams usually takes a little bit of work and discipline.

**The Microsoft Certification Program**

Microsoft currently offers multiple certification titles, each of which boasts its own special abbreviation. (As a certification candidate and computer professional, you need to have a high tolerance for acronyms.)

The newer certifications based on Windows Vista and Windows Server 2008 are as follows:

- **Microsoft Certified Technology Specialist (MCTS)**—For professionals who target specific technologies and distinguish themselves by demonstrating in-depth knowledge and expertise in the various Microsoft specialized technologies. The MCTS is a replacement for the MCP program.

- **Microsoft Certified IT Professional (MCITP)**—For professionals who demonstrate comprehensive skills in planning, deploying, supporting, maintaining, and optimizing IT infrastructures. The MCITP is a replacement for the MCSA and MCSE programs.

- **Microsoft Certified Architect (MCA)**—For professionals who are identified as top industry experts in IT architecture that use multiple technologies to solve business problems and provide business metrics and measurements. Candidates for the MCA program are required to present to a review board—consisting of previously certified architects—to earn the certification.
For trainers and curriculum developers, the following certifications are available:

- **Microsoft Certified Trainer (MCT)**—For qualified instructors who are certified by Microsoft to deliver Microsoft training courses to IT professionals and developers.

- **Microsoft Certified Learning Consultant (MCLC)**—For recognized MCTs whose job roles have grown to include frequent consultative engagements with their customers and who are experts in delivering customized learning solutions that positively affect customer return on investment (ROI).

For the best place to keep tabs on all Microsoft certifications, you need to view the following website:

http://www.microsoft.com/learning/default.mspx

Because Microsoft changes its website often, this URL may not work in the future. Therefore, you should use the Search tool on the Microsoft site to find more information on a particular certification.

**Microsoft Certified Technology Specialist (MCTS)**

Technology Specialist certifications enable you to target specific technologies and distinguish yourself by demonstrating in-depth knowledge and expertise in your specialized technologies. Microsoft Certified Technology Specialists are consistently capable of implementing, building, troubleshooting, and debugging a particular Microsoft technology.

At the time of the writing of this book, there are 19 Microsoft Certified Technology Specialist (MCTS) certifications:

- Technology Specialist: Maintaining Projects with Microsoft Office Project 2007
- Technology Specialist: Enterprise Project Management with Microsoft Office Project Server 2007
- Technology Specialist: .NET Framework 2.0 Web Applications
- Technology Specialist: .NET Framework 2.0 Windows Applications
- Technology Specialist: .NET Framework 2.0 Distributed Applications
- Technology Specialist: SQL Server 2005
The new Microsoft Certified IT Professional (MCITP) credential lets you highlight your specific area of expertise. Now, you can easily distinguish yourself as an expert in database administration, database development, business intelligence, or support. At the time of this writing, the following Microsoft Certified IT Professional certifications exist:

- IT Professional: Business Intelligence Developer
- IT Professional: Consumer Support Technician
- IT Professional: Database Developer
- IT Professional: Database Administrator
At the time of this writing, details are just starting to be revealed on the Microsoft Certified Technology Specialist (MCTS) on Windows Server 2008. The MCTS on Windows Server 2008 will help you and your organization take advantage of advanced server technology with the power to increase the flexibility of your server infrastructure, save time, and reduce costs. Transition certifications are available today for Windows Server 2003 certified professionals, and full certification paths will be available soon after the Windows Server 2008 product release. For more details about these certifications, visit the following website:


If the URL is no longer available, don’t forget to search for MCTS and Windows Server 2008 using the Microsoft search tool found on the Microsoft website.

Microsoft Certified Technology Specialist: Windows Vista, Configuration

The Microsoft Certified Technology Specialist certifications enable professionals to target specific technologies and distinguish themselves by demonstrating in-depth knowledge and expertise in their specialized technologies. A Microsoft Certified Technology Specialist in Windows Vista, Configuration possesses the knowledge and skills to configure Windows Vista for optimal performance on the desktop, including installing, managing, and configuring the new security, network, and application features in Windows Vista.

To earn the Microsoft Certified Information Technology Professional (MCITP): Enterprise Support Technician certification, you must pass two exams:

- Exam 70-620 TS: Microsoft Windows Vista Client, Configuring
- Exam 70-622 IT Pro: Supporting and Troubleshooting Applications on a Windows Vista Client for Enterprise Support Technicians
Exam 70-620 focuses on supporting end-user issues about network connectivity, security, and applications installation and compatibility, and logon problems that include account issues and password resets.

If you decide to take a Microsoft-recognized class, you can choose from two classes:

- Course 5115: Installing and Configuring the Windows Vista Operating System (3 days)
- Course 5116: Configuring Windows Vista Applications and Tools (2 days)

The preparation guide (including exam objectives) for Exam 70-620 TS: Microsoft Windows Vista, Configuring is available at
http://www.microsoft.com/learning/exams/70-620.mspx

Exam 70-622 focuses on IT professionals who typically work as Enterprise Support Technicians dealing with implementing, administering, and troubleshooting Windows Vista in an upper medium-sized organization or enterprise environment that uses Windows Vista.

If you decide to take a Microsoft recognized class, you can choose from two classes:

- Course 5118: Maintaining and Troubleshooting Windows Vista Computers (3 days)
- Course 5119: Supporting the Windows Vista Operating System and Applications (2 days)

The preparation guide (including exam objectives) for Exam 70-622 IT Pro: Supporting and Troubleshooting Applications on a Windows Vista Client for Enterprise Support Technicians is available at
http://www.microsoft.com/learning/exams/70-622.mspx

**Taking a Certification Exam**

After you prepare for your exam, you need to register with a testing center. At the time of this writing, the cost to take Exam 70-622 is (U.S.) $125, and if you don't pass, you can take the test again for an additional (U.S.) $125 for each attempt. In the United States and Canada, tests are administered by Thompson Prometric. Here's how you can contact the testing administrator:
Prometric—You can sign up for a test through the company’s website, http://www.2test.com or http://www.prometric.com. Within the United States and Canada, you can register by phone at 800-755-3926. If you live outside this region, you should check the Prometric website for the appropriate phone number.

To sign up for a test, you must possess a valid credit card or contact Prometric for mailing instructions to send a check (in the United States). Only when payment is verified or a check has cleared can you actually register for a test.

To schedule an exam, you need to call the appropriate phone number or visit the Prometric website at least one day in advance. To cancel or reschedule an exam in the United States or Canada, you must call before 3 p.m. Eastern time the day before the scheduled test time (or you might be charged even if you don’t show up to take the test). When you want to schedule a test, you should have the following information ready:

- Your name, organization, and mailing address.
- Your Microsoft test ID. (In the United States, this means your Social Security number; citizens of other countries should call ahead to find out what type of identification number is required to register for a test.)
- Your Microsoft Certified Professional (MCP) ID, if you have one.
- The name and number of the exam you want to take.
- A method of payment. (As mentioned previously, a credit card is the most convenient method, but alternate means can be arranged in advance, if necessary.)

After you sign up for a test, you are told when and where the test is scheduled. You should arrive at least 15 minutes early. You must supply two forms of identification, one of which must be a photo ID to be admitted into the testing room.

Tracking Certification Status

As soon as you pass your first qualified Microsoft exam and earn a professional certification, Microsoft generates a transcript that indicates which exams you have passed. You can view a copy of your transcript at any time by going to the MCP secured site at https://mcp.microsoft.com/mcp (this site may change as the MCP certification is retired), and selecting the Transcript Tool. This tool enables you to print a copy of your current transcript and confirm your certification status.
After you pass the necessary set of exams, you are certified. Official certification is normally granted after six to eight weeks, so you shouldn’t expect to get your credentials overnight. The package for official certification that arrives includes a Welcome Kit that contains a number of elements (see the Microsoft website for other benefits of specific certifications):

- A certificate that is suitable for framing, along with a wallet card and lapel pin.
- A license to use the related certification logo, which means you can use the logo in advertisements, promotions, and documents and on letterhead, business cards, and so on. Along with the license comes a logo sheet, which includes camera-ready artwork. (Note that before you use any of the artwork, you must sign and return a licensing agreement that indicates you’ll abide by its terms and conditions.)
- Access to the Microsoft Certified Professional Magazine Online website, which provides ongoing data about testing and certification activities, requirements, changes to the MCP program, and security-related information on Microsoft products.

Many people believe that the benefits of MCP certification go well beyond the perks that Microsoft provides to newly anointed members of this elite group. We’re starting to see more job listings that request or require applicants to have Microsoft and other related certifications, and many individuals who complete Microsoft certification programs can qualify for increases in pay and responsibility. As an official recognition of hard work and broad knowledge, a certification credential is a badge of honor in many IT organizations.

**About This Book**

Each topical *Exam Cram* chapter follows a regular structure and contains graphical cues about important or useful information. Here’s the structure of a typical chapter:

- **Opening hotlists**—Each chapter begins with a list of the terms, tools, and techniques that you must learn and understand before you can be fully conversant with that chapter’s subject matter. The hotlists are followed by one or two introductory paragraphs to set the stage for the rest of the chapter.

- **Topical coverage**—After the opening hotlists and introductory text, each chapter covers a series of topics related to the chapter’s subject.
Throughout each chapter, we highlight topics or concepts that are likely to appear on a test, using a special element called an Exam Alert:

**EXAM ALERT**

This is what an Exam Alert looks like. Normally, an alert stresses concepts, terms, software, or activities that are likely to relate to one or more certification-test questions. For that reason, we think any information in an alert is worthy of unusual attentiveness on your part.

You should pay close attention to material flagged in Exam Alerts; although all the information in this book pertains to what you need to know to pass the exam, Exam Alerts contain information that is really important. You’ll find what appears in the meat of each chapter to be worth knowing, too, when preparing for the test. Because this book’s material is condensed, we recommend that you use this book along with other resources to achieve the maximum benefit.

In addition to the alerts, we provide tips to help you build a better foundation for Windows Vista knowledge. Although the tip information might not be on the exam, it is certainly related and will help you become a better-informed test taker.

**TIP**

This is how tips are formatted. Keep your eyes open for these, and you’ll become a Windows Vista guru in no time!

**NOTE**

This is how notes are formatted. Notes direct your attention to important pieces of information that relate to Windows Vista and Microsoft certification.

- **Exam prep questions**—Although we address test questions and topics throughout the book, the section at the end of each chapter presents a series of mock test questions and explanations of both correct and incorrect answers.

- **Details and resources**—Every chapter ends with a section titled “Need to Know More?” This section provides direct pointers to Microsoft and third-party resources that offer more details on the chapter’s subject. In addition, this section ranks or at least rates the quality and thoroughness
of the topic’s coverage by each resource. If you find a resource you like in that collection, you should use it, but you shouldn’t feel compelled to use all the resources. On the other hand, we recommend only resources that we use on a regular basis, so none of our recommendations will be a waste of your time or money (but purchasing them all at once probably represents an expense that many network administrators and Microsoft certification candidates might find hard to justify).

The bulk of the book follows this chapter structure, but we’d like to point out a few other elements. The two practice exams provide good reviews of the material presented throughout the book to ensure that you’re ready for the certification exam.

Finally, the tear-out Cram Sheet attached next to the inside front cover of this Exam Cram book represents a condensed collection of facts and tips that we think are essential for you to memorize before taking the test. Because you can dump this information out of your head onto a sheet of paper before taking the exam, you can master this information by brute force; you need to remember it only long enough to write it down when you walk into the testing room. You might even want to look at the Cram Sheet in the car or in the lobby of the testing center just before you walk in to take the exam.

We’ve structured the topics in this book to build on one another. Therefore, some topics in later chapters make the most sense after you’ve read earlier chapters. That’s why we suggest that you read this book from front to back for your initial test preparation. If you need to brush up on a topic or if you have to bone up for a second try, you can use the index or table of contents to go straight to the topics and questions that you need to study. Beyond helping you prepare for the test, this book is useful as a tightly focused reference to what we think are some of the most important aspects of Windows Vista.

The book uses the following typographical conventions:

- Command-line strings that are meant to be typed into the computer are displayed in monospace text, such as

  `net use lpt1: \print_server_name\printer_share_name`

- New terms are introduced in italics.

Given all the book’s elements and its specialized focus, we’ve tried to create a tool to help you prepare for and pass Microsoft Exam 70-622. Please share with us your feedback on the book, especially if you have ideas about how we can improve it for future test takers. Send your questions or comments about this book via
email to feedback@quepublishing.com. We’ll consider everything you say carefully, and we’ll respond to all suggestions. For more information on this book and other Que Certification titles, visit our website at http://www.quepublishing.com. You should also check out the new Exam Cram website at http://www.examcram.com, where you’ll find information updates, commentary, and certification information.

Thanks for making this Exam Cram book a pivotal part of your certification study plan. Best of luck on becoming certified!
### Terms you’ll need to understand:

- ✓ Active Directory (AD)
- ✓ Active Directory Users and Computers (ADUC)
- ✓ Local Computer Policy (LCP)
- ✓ Group Policy Object (GPO)
- ✓ AD Site
- ✓ AD Domain
- ✓ Organizational Unit (OU)
- ✓ L-S-D-OU-OU-OU
- ✓ Block Inheritance
- ✓ No Override/Enforced
- ✓ Group Policy Management Console (GPMC)
- ✓ Task Scheduler
- ✓ Event Viewer
- ✓ Event Subscriptions
- ✓ Windows Remote Management Service (WinRM)
- ✓ Windows Event Collector Utility (wecutil.exe)
- ✓ Reliability and Performance Monitor
- ✓ Data Collector Set

### Techniques you’ll need to master:

- ✓ Install and use the Group Policy Management Console
- ✓ Create, deploy, and troubleshoot Group Policy Objects (GPOs)
- ✓ Understand GPO processing
- ✓ Implement a Loopback GPO
- ✓ Implement an audit policy
- ✓ Implement a software deployment GPO
- ✓ Implement Device Restrictions by GPO
- ✓ Implement Software Restrictions by GPO
- ✓ Perform Resultant Set of Policies/Planning and Logging
- ✓ Schedule tasks with different triggers
- ✓ Understand Event Viewer
- ✓ Configure Event Forwarding from multiple Source computers to one Collector computer
- ✓ Configure Data Collector Sets in Performance Monitor
The tools that you must be familiar with and use in the management of Windows Vista computers in the enterprise are

- Active Directory Users and Computers (ADUC)
- Group Policy Management Console (GPMC)
- Group Policy Objects (GPO)
- Task Scheduler
- Event Viewer
- Reliability and Performance Monitor

As an enterprise support technician, you are responsible for management and maintenance of computers that run Windows Vista in the Enterprise. Your “heavy guns” in this administrative task are the Group Policy Objects (GPOs). You need to be fluent with their settings, the way they get processed, and the implementation and troubleshooting of GPOs in your enterprise environment.

The exam tests your knowledge of what settings are available, where to link the GPO, how to have the GPO apply to only selected computers or users, and how to troubleshoot them when you aren’t getting what you expected from the GPOs.

Another tool that you use is the Task Scheduler. This tool launches tasks at a later and perhaps regularly scheduled time. This tool has changed significantly since the last versions of the Windows operating system.

There is impressive new capability in the Event Viewer. You probably won’t even recognize it from earlier versions. It has a powerful, customizable filter that allows you to capture events of about any nature you can imagine. In addition to this capability, you can now aggregate events from remote computers onto a single monitoring system, through the use of Event Forwarding to an Event Collector and subscription services.

Finally, you look at the new and improved Reliability and Performance Monitor, where you configure counters to view and log performance parameters on the local and on remote computers. This new tool includes a collection of objects and counters to monitor a large number of system resources.

You can configure many of the configuration parameters in the Local Computer Policy (LCP) on each client computer that runs Windows Vista. In the corporate enterprise, remember that these numerous configuration settings can and typically should be centrally managed and deployed by GPOs within the Active Directory structure.
Some exam questions address a standalone Windows Vista computer, whereas others address the Windows Vista computer within an Active Directory environment. You need to know what security settings are available and how these controls affect the behavior of the Windows Vista computer in both cases. So put on your seatbelts and read on carefully.

**Group Policy Object Overview**

Policies are the way that computers are managed, either standalone computers or computers in the enterprise. Policies establish the vast majority of the configuration settings that control how the computer boots up and then how your desktop environment is constructed when you log on.

**The Standalone Computer**

Each computer has a Local Computer Policy, or LCP (also referred to as the *Local GPO* or *LGPO*), that is made up of many configuration settings on the various configuration dialog boxes throughout the user interface, as well as numerous settings that are configurable only in a Microsoft Management Console (MMC) called the Local Computer Policy. This policy is stored in the Registry on the computer’s hard drive and is applied every time the computer is booted up. This computer configuration from the Local Computer Policy gets read into random access memory (RAM) on the computer. Think of this RAM copy of the Registry as the live, awake brain of the computer when it is booted up. This RAM copy of computer settings from the Registry is in place when you are presented with the Windows Graphical Identification aNd Authentication (GINA) dialog box.

Further configuration for the desktop environment is controlled by configuration parameters stored within your user profile in a file called `NTUSER.DAT`. `NTUSER.DAT` gets read into RAM from your profile folder when you successfully log on to the computer. As you make changes to your desktop environment, like the desktop wallpaper or items on the Start menu, these changes get recorded in the RAM copy of `NTUSER.DAT`. When you log off, by default, the operating system saves these changes into your profile. This file is the primary source of the configuration parameters that define your desktop environment.

The first time you log on to a computer, the operating system copies a read-only and hidden folder under `C:\Users` called `\Default` to a new folder under `C:\Users` and renames the new folder with your logon name. Within that folder is the file named `NTUSER.DAT`. This becomes your user profile on this specific computer. After that first logon on a given computer, now that you have an existing profile, this existing copy of `NTUSER.DAT` is the one that gets read into RAM for your user profile.
To summarize, two components define a desktop environment on a standalone computer (not participating within an Active Directory environment): the configuration parameters in the Local Computer Policy and the configuration parameters in your user profile. They get applied in that order.

The LCP can be accessed on a Windows Vista computer by building it into a new MMC.

**Building a Local Computer Policy (LCP)**

To build the Local Computer Policy (LCP) MMC, follow these steps:

1. Click **Start > Run**, type **MMC**, and click **OK**. (You can also use **Start > Start Search > MMC** and then press **Enter**.)
2. From the menu, select **File > Add / Remove Snap-in**.
3. Select **Group Policy Object snap-in** and click **Add**.
4. Accept the Group Policy Object for the Local Computer by clicking **Finish**.
5. Click **OK**.
6. From the menu, select **File > Save As**.
7. Type **LCP.msc** and save the MMC either on the desktop or in Administrative Tools.

**The Domain Member Computer**

Back in the old days of the Windows NT domain and Windows 95 clients, Microsoft used something called System Policies, built using a tool called the System Policy Editor, to manage and configure these down-level computers. These System Policies would “tattoo” the Registry of the local box, actually writing settings to the Registry files on the local hard drive. If you wanted to remove policy settings from the computers, you had to write a new System Policy that would actually reverse the settings from the policy that was being removed.

When Windows 2000 was released, Microsoft implemented a whole new generation of policies and completely overhauled how they were applied on computers. These policies were improved yet again with the release of Windows XP, Windows Server 2003, and now again with Windows Vista. These new policies are called Group Policy Objects, or GPOs, and they exist in the Active Directory in
an enterprise environment. These policies get applied to the computer over the top of the Local Computer Policy and your user profile settings to provide enterprise administrative dominance over the local configuration settings.

**NOTE**

**GPOs Apply to Domain Members Only** Keep in mind that GPOs affect only computers and users that are members of an Active Directory domain. If the computer and user are not members of an AD domain, only the Local Computer Policy and the user’s profile get applied to the user’s desktop session. No GPOs. If you apply a GPO in AD and don’t see the effects on the computer and user, double-check to be sure that the computer and user are members of the AD domain.

These new policies do not affect the configuration files on the hard drive (for the most part), so they do not “tattoo” the computer. Rather, as these new policies get applied, they modify the copy of the Registry (computer) and the profile (user) that has been read into RAM on the computer during the initial bootup and then the user logon for the current session. These modifications to settings do not get written back to the hard drive copies of the configuration files. Remember that this RAM copy is the actual functional copy that is being used to control and configure the user’s current session.

**L-S-D-OU-OU-OU**

Active Directory (AD) is a database and a collection of directory services that support the database and the network operating system. AD is created by configuring one or more domain controllers on a network. AD utilizes four types of containers to store and organize AD objects, like computers and users:

- Forests
- Sites
- Domains
- Organizational Units

You can apply GPOs to sites, domains, and Organizational Units.

**AD Forest**

The AD forest is one or more AD domains that share a common schema. The schema is the structure of the AD database—not the data within the database, just the structure. The forest is created when you run *Dcpromo* on a server to install your first domain controller in the first domain in the forest. This first
domain is referred to as the *forest root domain*. The name of this forest root domain also is the name of the forest. All domains within the forest are trusted by and trusting of all other domains within the forest. Therefore, since members of your forest are, by default, all trusted and trusting, a lack of trust with some new domain indicates the need to generate a second forest, or create the new, untrusted domain in a different, existing forest. Forests are logical containers and have no real connection to any physical location, other than you must place your domain controllers somewhere. GPOs cannot be linked to the forest.

**AD Sites**

*AD sites* are created in AD once the forest is established and are defined as a collection of well-connected segments, where the bandwidth is at least local area network (LAN) speed. LAN speed is currently considered to be 10Mbps or greater. Any network link between segments that drops below LAN speed is defined as a boundary of the site and indicates the need for the creation of an additional site. Because sites are defined by physical connectivity, they are considered to be physical containers, with one site per location that is connected to AD by slower links. There are two major benefits to defining sites:

- Client computers within a site are preferentially directed to local (within the same site) resources.
- AD replication within the site happens without much regard for bandwidth consumption (because all segments are well connected at high bandwidth LAN speeds), but AD replication between sites, over slower wide area network (WAN) links, can be carefully controlled so as to avoid saturation of these lower bandwidth links. GPOs can be linked to sites.

**AD Domains**

*AD domains* are logical containers that are created within an AD forest. Domains (and AD) are created, and exist, on domain controllers. Domains in AD are security boundaries. In Windows Server 2003, they are defined by their unique namespace, like mobeer.com, buymeabeer.us, or boboville.com, as well as their single-password policy per domain. If you need a different namespace, you need another AD domain. If you need a different password policy for users, you need another AD domain. Domains are logical containers and can exist in multiple sites if placed in one or more domain controllers in more than one site. GPOs can be linked to the domain.
Organizational Units (OUs)

Organizational Units (OUs) are logical containers that are created within an AD domain. They are designed to be used to organize computers and users for two purposes: to delegate administrative authority of groups of computers and users to different administrators, and to provide grouping of computers and users for the assignment of different Group Policy Objects (GPOs). OUs can be nested within another parent OU, so they create a hierarchical structure, like the one shown in Figure 3.1. GPOs can be linked to Organizational Units.

The OU is represented in AD Tools by a folder with a book icon on it. A folder without a book icon on it is not an OU but is an AD container that cannot have GPOs linked to it. By default, AD provides only one OU called the Domain Controllers OU so that security-related GPOs can be applied to this most sensitive class of servers. Administrators must create all other OUs.

Policies are applied in the order of L-S-D-OU-OU-OU. That is the Local policy, then site policies, then domain policies, and finally OU policies, starting with the top-level OU, and then followed by its child OU, and then its child OU, and so on.
Policies have two halves:

- A computer half, called the **Computer Configuration**
- A user half, called the **User Configuration** (see Figure 3.2)

### Applying GPOs to a Computer and User in an AD Environment

GPOs are applied to a computer and user in an AD environment as follows.

The computer is turned on. All the Local settings are read from the files on the local hard drive that make up the Registry and the Local Computer Policy (LCP) and are placed in RAM. Again, think of this RAM copy of the Registry as the live, awake brain for this session on the computer. This is the “L” part of the computer boot-up process.

Because the computer is a member of Active Directory, it contacts a domain controller for its domain and authenticates its computer account with AD. It then compares its IP address to IP subnets configured in AD sites to identify which site the computer is currently in. The computer then downloads and reads all GPOs for the site that it is currently in and applies only the computer half of those GPOs to the RAM copy of the Registry on the computer. (At this point in the bootup process, it cannot apply the user portion because there is no way to know what user will eventually be logging on.) If any Site level settings conflict with any Local settings, the Site level settings override the Local settings. This is the “S” part of the computer bootup process.

The computer then downloads and reads all GPOs for the domain that it is a member of and applies only the computer half of those GPOs to the RAM copy of the Registry on the computer. By default, if any Domain level settings conflict
with any Local or Site level settings, the Domain level settings override the Local and Site level settings. This is the “D” part of the computer bootup process.

The computer then downloads and reads all GPOs for the top-level OU that its computer object resides in and applies only the computer half of those GPOs to the RAM copy of the Registry on the computer. By default, if any OU level settings conflict with any Local, Site, or Domain level settings, the OU level settings override the Local, Site, and Domain level settings. This is the “OU” part of the computer bootup process.

The computer repeats this process for each level OU that it may reside within. If the computer object for the computer resides in the top-level OU, these are the only OU GPOs to be processed. If the computer object for the computer resides in the third-level OU, the top-level OU GPOs are processed, then the second-level OU GPOs are processed, and finally the third-level OU GPOs are processed. By default, the last GPO that gets applied overrides all conflicts with previously applied GPOs.

Again, these GPO policies get applied to the computer over the top of the Local Computer Policy settings to provide enterprise (AD) administrative dominance over the local configuration settings.

When all appropriate OU GPOs are processed, the Windows GINA dialog box is presented, and finally you are allowed to attempt to log on.

You are prompted to press and hold the Ctrl+Alt keys and then press the Del key to initialize the logon process, as shown in Figure 3.3. You then provide your identity information, your username and password, and click Enter.

FIGURE 3.3 You provide your identity information, your username and password, and then click Enter.
When your identity information is accepted as valid by a domain controller, you are authenticated, and the L-S-D-OU-OU process begins all over again. Only this time it uses your user profile (L) and the user half of the S, D, and OU GPOs, as follows.

The user profile settings are read from the files on the local hard drive and are placed in RAM. This is the “L” part of the user logon process.

The computer again compares its IP address to IP subnets configured in AD sites to identify which site the computer is currently in. The computer then downloads and reads all GPOs for the site that it is currently in and applies only the user half of those GPOs to the RAM copy of the Registry on the computer. If any Site level settings conflict with any Local settings, the Site level settings override the Local settings. This is the “S” part of the user logon process.

The user object can be located in a different OU and even a different domain than the computer object, but because you are logging on to the computer, you must be in the same physical location as the computer and are subject to the computer’s Site level GPOs.

The computer then contacts a domain controller for the domain that you are a member of and downloads and reads all GPOs for your domain. The computer applies only the user half of those GPOs to the RAM copy of the Registry on the computer. By default, if any Domain level settings conflict with any Local or Site level settings, the Domain level settings override the Local and Site level settings. This is the “D” part of the user logon process.

The computer then downloads and reads all GPOs for the top-level OU that the user account object resides in and applies only the user half of those GPOs to the RAM copy of the Registry on the computer. By default, if any OU level settings conflict with any Local, Site, or Domain level settings, the OU level settings override the Local, Site, and Domain level settings. This is the “OU” part of the user logon process.

The computer repeats this process for each level OU that the user account object may reside within. If the user account object resides in the top-level OU, these are the only OU GPOs to be processed. If the user account object for the computer resides in the third-level OU, then the top-level OU GPOs are processed, followed by the second-level OU GPOs, and finally the third-level OU GPOs are processed. By default, the last GPO that gets applied overrides all conflicts with previously applied GPOs.

Once again, these policies get applied to the RAM copy of the Registry on the computer over the top of the User Profile settings to provide enterprise (AD) administrative dominance over the local configuration settings.

Now you (finally) get your desktop and can begin working.
And If That Isn’t Enough: Enforced, Block Inheritance, and Slow Link Detection

With all the different GPOs that can be applied to a computer and user, some settings in the different GPOs are bound to conflict. Suppose at the site level, a GPO sets the desktop wallpaper for all computers in the site to the company logo wallpaper. And then some domain administrator sets a GPO at the domain level so that the desktop wallpaper for all domain computers is a picture of the domain’s softball team. By default, if any settings in the numerous GPOs conflict, the last GPO that gets applied wins the conflict.

This sounds like the lowliest administrator in charge of two or three computers and a few users in an OU can overrule the highest level enterprise administrator in charge of hundreds or thousands of computers and users. If left to the defaults, this is true. However, there is a setting called Enforced on each GPO. If this setting is enabled (it is not enabled by default), it locks every setting that is configured in the GPO, and no GPO that follows can override these locked settings. So with the Enforced setting enabled on GPOs, the first Enforced GPO that gets applied wins all conflicts. This is a top-down mechanism.

Another configurable setting regarding GPO processing is a bottom-up mechanism. If an administrator at a domain or some OU level does not want any previously applied, non-Enforced GPOs to affect his computers and users, he can enable a setting called Block Inheritance on the domain or the OU. This setting turns off processing of all GPOs from higher-level containers that are not Enforced. Remember, though, that a GPO with the Enforced setting enabled blows right past the Block Inheritance setting and is still processed by all computers and users in all child containers, even if the Block Inheritance setting is enabled.

One more parameter that changes the way GPOs are processed has to do with the bandwidth connecting the client computer to the domain controllers. Because some GPOs trigger a large amount of network traffic—a software deployment and folder redirection GPOs, for example—an evaluation of the bandwidth of the link to AD is performed before processing any GPOs. This is referred to as Slow Link Detection. If the link speed is below 500Kbps, the default data rate for a slow link, software GPOs do not deploy software, and folder redirection GPOs do not relocate folders. If a computer cannot identify the bandwidth of the link to AD, it assumes that it is using a slow link and may not process all appropriate GPOs, like the software deployment GPOs.
Chapter 3: Managing and Maintaining Systems That Run Windows Vista

EXAM ALERT

In earlier versions of Windows, like Windows XP, the client computer utilized the Internet Control Message Protocol (ICMP) Echo Request, the same function used in the PING application, to perform the slow link detection process. This became problematic when we all began blocking ICMP Echo Requests on our firewalls, due to the numerous Denial of Service attacks that used it. Client computers began to fail to identify slow links, and therefore they would fail to process all appropriate GPOs because the firewalls on the domain controllers blocked their slow link detection mechanism, the ICMP Echo Request packets.

Windows Vista has solved this problem by using a different service to identify slow links. Windows Vista uses a service called Network Location Awareness, instead of ICMP, to perform Slow Link Detection so that all appropriate GPOs are processed by Windows Vista computers.

To ensure Windows XP computers process all appropriate GPOs, you might need to allow ICMP Echo Request packets through your firewalls.

GPO Refresh, Loopback GPO Processing, and Turning Off the “L”

A few settings within the GPO also can affect the way this GPO processing happens. The first one is called the GPO Refresh. GPOs are applied to the computer during its bootup and then to the user during logon. They also get reapplied on a regular interval to ensure that new GPOs take effect quickly.

By default, GPOs refresh on member servers, member client computers, and domain users every 90 minutes, plus a random offset of 0 to 30 minutes (90 to 120 minutes). GPOs refresh on domain controllers every 5 minutes and have no random offset. These default refresh intervals can be adjusted within the GPO to affect all future refresh intervals. You can make this adjustment under User Configuration > Administrative Templates > System > Group Policy for the user refresh, and under Computer Configuration > Administrative Templates > System > Group Policy for domain member servers, domain member client computers, and domain controllers, as shown in Figure 3.4.

EXAM ALERT

Remember that you can manually refresh GPOs by running the gpupdate.exe /force command on the target computer. The /force switch reapplies all applicable GPO settings.
Another tool within a GPO that affects the way GPOs get processed is called **Loopback**, and it has two modes: Merge and Replace.

**EXAM ALERT**

You typically use Loopback when the computer is located in a public area, and you want to minimize or eliminate any User GPO settings that might be applied to the computer session.

With Loopback Merge mode enabled, after the GPO processing described earlier (L-S-D-OU-OU-OU for the computer and then L-S-D-OU-OU-OU again for the user) completes, Loopback Merge mode kicks in and reapplies the computer settings, just in case any user settings conflict with any computer settings. Remember, the last GPO that applies wins conflicts, by default. User GPOs apply after computer GPOs by default. Loopback reappplies the computer settings to win any conflicts with user settings.

With Loopback Replace mode enabled, after the GPO processing described earlier completes, Loopback Replace mode kicks in and reapplies the computer settings, just in case any user settings conflict with any computer settings. Then Loopback Replace mode throws away every user GPO setting that has been applied, and it processes the user half of all GPOs (S-D-OU-OU-OU) that apply to the computer's position in AD, not the user's position in AD. The Loopback processing GPO is shown in Figure 3.5.
Another GPO setting that affects GPO processing is used to turn off Local Group Policy objects processing. You can access this setting under Computer Configuration\Administrative Templates\System\Group Policy in the Group Policy Management Console running on a Windows Vista computer, as shown in Figure 3.6.

![FIGURE 3.5 Using Loopback Merge mode or Loopback Replace mode to minimize or eliminate user GPO settings.](image)

![FIGURE 3.6 Disabling the processing of the Local Computer Policy.](image)
EXAM ALERT

Enabling the Turn Off Local Group Policy Objects Processing GPO setting disables policy processing for the L part of L-S-D-OU and processes only S-D-OU.

NOTE

New GPOs There are approximately 800 new GPO settings exclusively for Windows Vista. You can access these new settings only by running GPMC and the Group Policy Object Editor (GPOE) on a Windows Vista computer. You cannot access these new Vista GPO settings from GPOE running on a Windows Server 2003 computer.

To be able to use and save the GPMC MMC on a Windows Vista computer, you must use a computer that is a member of an AD domain, and you must be logged in with a domain user account with sufficient privilege to create and edit GPOs.

You can access the Group Policy Management Console (GPMC), as shown in Figure 3.7, on a Windows Vista computer by building a new MMC.

FIGURE 3.7 Accessing the Group Policy Management Console.

Building the Group Policy Management Console (GPMC) MMC

To build the Group Policy Management Console (GPMC) MMC, follow these steps:
1. Click **Start > Run**, type **MMC**, and click **OK**. (You can use **Start > Start Search > MMC >** and click Enter.)

2. From the menu, select **File > Add / Remove Snap-in**.

3. Select **Group Policy Management snap-in** and click **Add**.

4. Click **OK**.

5. From the menu, select **File > Save As**.

6. Type the name **GPMC.msc** and save the MMC either on the desktop or in Administrative Tools.

To create a new GPO in the GPMC tool, follow these steps:

1. Expand Forest, Domains, and your domain name.

2. Right-click the folder **Group Policy Objects** and select **New**.

3. Give your new GPO a descriptive name so that you know what is configured in the GPO.

To edit the new GPO, right-click the new GPO in the **Group Policy Objects** folder and select **Edit**. This opens the GPO in the Group Policy Object Editor (GPOE).

To link a GPO to a site, domain, or OU in the GPMC tool, follow these steps:

1. Expand the appropriate folder to be able to view the target container.

2. Click the desired GPO and drag it to the target container and release. This creates a link between the GPO and the container.

**EXAM ALERT**

The exam focuses on processing order, blocking inheritance (enforced), delegation, loopback processing modes, and so on.

**CAUTION**

**Use Care When Dealing with GPOs**

Two GPOs are provided by default in every new domain. They are the Default Domain Policy and the Default Domain Controllers Policy. These policies are generally LEFT ALONE, with no new settings added. These policies have many carefully conceived, preconfigured settings to control and secure your domain and domain controllers (DCs).

You might make an occasional adjustment to a preconfigured setting or two inside these policies, but these changes should be carefully considered, planned, formally approved by senior IT administration, and carefully implemented. If you want to add GPO settings to the domain or to the DCs, create new GPOs with your desired settings and link them in the proper locations.
Group Policy Settings

Now that you know how GPOs are processed, what can you do with them anyway? The GPO that was used on Windows Server 2003 and Windows XP had about 1,700 settings (1,671, as of March 31, 2005). The new GPO for Windows Vista has approximately 2,500 settings (2,495 with the initial release of Vista, to be exact). So what can you do with a GPO in Windows Vista? A lot and then some. The truth is that every configurable parameter of the operating system and every configurable parameter of every application that uses the Registry can be controlled with a GPO. Even if the Registry key or value doesn’t exist, it can be added by GPO and then configured by GPO. So the real answer is that approximately everything on the computer that uses or could use the Registry can be controlled by GPO.

The next intelligent question might be “So what are they going to test me on?” That is an excellent question. You’re going to look at a handful of specific GPO uses and settings that are potential targets on the exam.

CAUTION

GPOs Are Powerful Mojo  GPOs can cause you significant trouble if you create and link them in the wrong places. If you are following along with the book on these settings, banging around inside GPOs, toggling on and off settings, and so on, it is a good idea to create yourself a new, empty OU to link your new trial GPOs to. I usually call my bogus OUs BOGUS. Then you can create user objects and computer objects, place them inside the BOGUS OU, link your new GPOs to the BOGUS OU, and then test the GPOs. Use extreme caution if you plan to have the GPO affect the computer that you use regularly. GPOs can and will change a computer’s behavior, and sometimes for the worse. You actually need at least one computer to test out the computer settings. Virtual machines perhaps?

Desktop Settings

One of the first target areas has to do with locking down your Desktop settings. Remember that GPOs have two halves: the computer configuration half and the user configuration half. Desktop settings are user-based settings, so you can find these settings in a GPO under User Configuration > Administrative Templates > Desktop, as shown in Figure 3.8.
FIGURE 3.8 Desktop controls by GPO are in the user configuration half.

Software Deployment by GPO

The next area to look at is software deployment GPOs. These are used to deploy applications to many computers or users automatically, over the network.

Software can only be assigned to the computer by GPO. Software can also be published or assigned to the user by GPO. The exam question should identify if the target is the computer or the user. Read the exam question carefully.

EXAM ALERT

If a software deployment package is assigned to either the computer or user, it is mandatory and is not optional. The software is deployed at computer bootup or at user logon (unless a slow link is detected).

If the software deployment package is published to the user, it is optional and you may, at your discretion, choose to install the software or choose not install the software (again, unless a slow link is detected).

If the software is assigned to the computer, it is installed at computer bootup, by default. If the software is assigned to the user, it is installed at user logon, by default. If the software is published to you (the user), you have to install the application by using Control Panel > Programs > Get Programs.

Applications can also be configured for deployment by enabling the Auto-install This Application By File Extension Activation setting. This means that if the
application being published is Excel, for example, you might trigger its installation by double-clicking on a file with an .xls extension.

GPOs can be used to deploy application software packages with the following extensions:

- **.MSI**—A Microsoft Installer package. This is the preferred software deployment package format. These files can be installed automatically, uninstalled automatically, and even repair themselves (application maintenance) if any of the application’s files on the client computer go missing or corrupt.

- **.MST**—A Microsoft Transform file. These files are used to modify the installation behavior of an .MSI package—for example, to deploy only Word and Excel from the MS Office suite.

- **.MSP**—A Microsoft Patch file. These files are used to deploy patches for Microsoft and third-party applications. (MS application patches are usually deployed through Microsoft Update these days.)

- **.ZAP**—A script file used to deploy software packages that do not have an .MSI file for deployment. This script must be created by an administrator to deploy software when all that is available is a Setup.exe, or the like. Although these files can be used to deploy software, the .ZAP file cannot be used to maintain or automatically uninstall the deployed software.

The software deployment package must reside on a network share, and users must have at least Allow—Read permissions on the share and on the NTFS permissions for the package. This network share point is called the Software Distribution Point (SDP).

**NOTE**

**Software Distribution Point Permissions**  
Typically, domain administrators are granted Full Control permissions to the SDP and content so they can do whatever they might need to do to maintain and fix any issues that might occur with the software deployment packages.

**EXAM ALERT**

Remember that only the .MSI software deployment packages can be used to automatically uninstall deployed software. You can configure the deployment package to uninstall at next bootup (computer) or Logon (user), or you can configure the GPO to uninstall this application when it falls out of the scope of management. This setting uninstalls the software automatically if the user or computer gets moved from the container (S-D-OU) that the software deployment GPO is linked to, or if the GPO is removed from the container that holds the user or computer. This GPO configuration setting is shown in Figure 3.9.
Chapter 3: Managing and Maintaining Systems That Run Windows Vista

Software Restrictions

The next major area of GPO category is in Software Restrictions. These GPOs are used to deny all executables except those specifically allowed using the Restricted Default Rule, or used to allow all executables and then disallow specific executables using the Unrestricted Default Rule. These GPO settings are located in the GPO under Computer Configuration > Windows Settings > Security Settings > Software Restriction Policies.

By default, the execution of applications is configured as Unrestricted, as shown in Figure 3.10. Application execution is intended to be controlled by the access permissions (share and NTFS) of the user on the executable.

FIGURE 3.9 Enable the software deployment setting to Uninstall This Application When It Falls Out of the Scope of Management.

FIGURE 3.10 By default, software execution is unrestricted.
You can configure permissions to keep users from executing applications. You need to do this on each computer where the application resides, a huge task in a large environment. Or you can do it much more easily and on a larger scale by creating a GPO with Software Restriction Rules and then link them appropriately.

Four types of Software Restriction Policy Rules can be used to modify the Default Rule:

- **Certificate Rule**—A digital signature embedded within the executable file.
- **Hash Rule**—A numeric fingerprint of the executable file.
- **Internet Zone Rule**—From tab. They include Internet, Local Intranet, Trusted Sites, and Restricted Sites.
- **Path Rule**—The local path or UNC path to the executable file.

These rules are shown in Figure 3.11.

These rules often get applied in combinations, and it can get tricky to figure out which GPOs will effectively restrict which applications. As GPOs get processed on the computer, the Software Restriction GPOs are evaluated and then are prioritized in the following order:

1. Certificate Rule—Strongest
2. Hash Rule
3. Path Rule
4. Internet Zone Rule
5. Default Rule—Weakest
Managing Device Installation

Another powerful control within a GPO that you have over users is the device installation management. This has been a security concern for years. How do you keep users from using USB thumb drives and USB CD/DVD burners to take copies of confidential data and programs away from the office? I have heard...
of companies actually gluing the USB mouse and keyboard into the USB ports and then filling all other USB ports with glue just to prevent the use of USB thumb drives that could be used to steal confidential data. Not exactly the perfect solution, but one that addresses the security vulnerability. But now what do you do if the mouse or keyboard fails?

Windows Vista and Windows Server 2008 have addressed and solved this problem through new GPO settings that can control what types of devices can be installed by users, by administrators, or both. These Device Installation GPO settings can be configured on a Windows Vista or Windows Server 2008 computer under Computer Configuration > Administrative Templates > System > Device Installation > Device Installation Restrictions, as shown in Figure 3.13.

![Figure 3.13 Setting the Device Installation Restriction policies.](image)

Standard users are not allowed to install many devices. However, by default, they can install a handful of devices, like USB thumb drives.

Devices are identified by Setup Classes (a Registry key) or by Device IDs (a more descriptive label for the devices). By using these identification values, you can configure Prevent Installation policies to include USB thumb drives and other types of devices, as shown in Figure 3.14.

You can configure a GPO to establish a default Prevent Installation of Devices Not Described by Other Policy Settings policy, and then you can configure Allow Installation policies only for specific devices that you want users to be able to install.

The Prevent Installation of Devices Not Described by Other Policy Settings policy setting disallows even an administrator from installing restricted devices. If you need to allow administrators to install restricted devices, you must enable the Allow Administrators to Override Device Installation Restriction Policies, as shown in Figure 3.15, and link it to the appropriate AD container (site, domain, or OU).
Chapter 3: Managing and Maintaining Systems That Run Windows Vista

FIGURE 3.15 Setting Allow Device Installation policies for users and for administrators.

The Audit Policy

Auditing is a critical component of the security program for every company. You can configure systems to record what your users do (Success) and what your users attempt to do (Failure). Audit policies are defined within the Local Computer Policy (LCP) and within GPOs. The audit policy is located under Computer Configuration > Windows Settings > Security Settings > Local Policies > Audit Policy. You can configure nine audit policies, as shown in Figure 3.16.
Audited events get recorded in the Security log on the computer where the event occurs and can be reviewed in the Event Viewer on that computer. The Security logs (and any other types of events) from multiple Windows Vista computers can be forwarded to an Event Collector server, a topic addressed later in this chapter.

Most of the audit policies require only the LCP or GPO settings configured to be effective. Two of the audit policies require some additional configuration in addition to the GPO audit policy settings to be effective. They are Directory Service Access and Object Access policies. The additional settings that are required reside on the properties of the objects being tracked by the audit policy and must be configured on the objects’ System Access Control List (SACL). (This may also be called the Security Access Control List—SACL.) The GPO turns on the auditing engine, and the SACL identifies specifically which users and which objects will be tracked.

You can access the SACL by following these steps:

1. Right-click on the Files, Folders, Printers, or AD objects of interest and select Properties.
2. Select the Security tab and click Advanced.
3. Select the Auditing tab to access the SACL for these types of objects.
Chapter 3: Managing and Maintaining Systems That Run Windows Vista

TIP

If the Security tab is not visible on AD objects, you must select View > Advanced Features from the menu to enable it.

On Registry objects, after enabling the Audit Object Access audit policy, right-click the desired Registry object and select Permissions. Click Advanced and select the Auditing tab. This is the SACL for Registry Keys, Values, and Data, as shown in Figure 3.17.

EXAM ALERT

The following is a review of what each audit policy setting accomplishes:

- **Audit Account Logon Events**—Logs a user’s domain account logons on the domain controller (DC).
- **Audit Account Management**—Logs changes to user objects in AD.
- **Audit Directory Service Access**—Logs access to objects in AD. This audit policy setting requires the additional SACL configuration on the AD objects of interest.
- **Audit Logon Events**—Logs a user’s local account logons on the local computer.
- **Audit Object Access**—Logs access to Files, Folders, Printers, and Registry components (Keys, Values, and Data). This audit policy setting requires the additional SACL configuration on the objects of interest.
- **Audit Policy Change**—Logs changes to user rights, auditing, or trust settings within GPOs.
- **Audit Privilege Use**—Logs the use of rights that have been granted.
- **Audit Process Tracking**—Logs actions of and interactions between applications.
- **Audit System Events**—Logs shutdowns and events that affect the System or Security logs.

Understand the difference between the Audit Account Logon Events and the Audit Logon Events audit policies!
Point and Print Restrictions

Point and Print restrictions allow you to control access to selected shared printers on the corporate network. By default, printers are shared with the permissions set to Allow—Print for the Everyone group. This says that any user can connect to a shared printer, automatically download any required printer drivers, and submit print jobs to that device. Permissions can be adjusted on the printer properties to further control this access. The Point and Print restrictions in a GPO can be used in addition to these permissions to control printer access for large groups of users in an AD environment.

This setting is located under User Configuration > Administrative Templates > Control Panel > Printers, as shown in Figure 3.18.

The fully qualified domain name (FQDN) of the print server must be added to complete the GPO setting.

This GPO setting requires that you construct a list of print servers that the users are allowed to download drivers from and then submit print jobs to. You can further restrict the driver download to only those drivers that have been tested, approved, and digitally signed by Microsoft’s Windows Hardware Quality Labs (WHQL), the testing arm of Microsoft for third-party drivers.
Chapter 3: Managing and Maintaining Systems That Run Windows Vista

Digital Certificates and Authenticode

As users connect to web servers, their browsers download the HTML file and image files and also download and execute active content, like ActiveX controls. Active content, also called mobile code, is a major source of malware (viruses and spyware) and is often heavily restricted in a corporate environment.

To ensure that your ActiveX controls are safe and usable by all who visit your website is to have the ActiveX control tested and digitally signed by Microsoft. When an ActiveX control is signed by Microsoft, it is called Authenticode, and it is generally trusted to be safe for your users to run. However, on occasion, these tested and approved ActiveX controls can still conflict with other software running on your client computers, so having it signed by Microsoft is still not a guarantee of safety.

CAUTION

Be Careful with Authenticode Restrictions Enabling restrictions on your browsers to allow only approved publishers of Authenticode enhances the security of browsing but can cause web applications and other website functions that rely on unsigned and unapproved publishers of ActiveX controls to fail.

You can restrict the browsers on your users’ computers to execute Authenticode only from a select list of publishers that you approve. To do this, you must enable a setting in a GPO that is located under User Configuration > Windows Settings > Internet Explorer Maintenance > Security > Authenticode Settings. The setting is labeled Enable Trusted Publisher Lockdown. This setting, shown in Figure 3.19, disables users from accepting any certificates (used in the Authenticode) from publishers that aren’t on your approved publishers list.
Troubleshooting Policy Settings

With all the complexity of GPO processing through the series of L-S-D-OU-OU-OU, and with Block Inheritance and Enforced settings, you might easily recognize that, on occasion, what you get from your collection of GPOs isn’t exactly what you expected. To help you sort through this maze of policies and settings, Microsoft has provided several different tools.

Group Policy Results and Group Policy Modeling

The first two tools, and probably the most recommended, can be accessed within the Group Policy Management Console (GPMC):

- Group Policy Results
- Group Policy Modeling

These two tools and a summary from the Group Policy Results tool, are shown in Figure 3.20.
Chapter 3: Managing and Maintaining Systems That Run Windows Vista

**The Group Policy Results Tool**
The Group Policy Results tool allows you to identify the effective GPOs and their settings that configure and control the user’s session on the computer. You specify which computer and which user to run the analysis on. The Group Policy Results tool performs its analysis based on where the specified computer account actually is located within AD and where a specified user account actually is located within AD to produce the effective GPO results. The Group Policy Results tool is often called the “What is” analysis tool.

**The Group Policy Modeling Tool**
The Group Policy Modeling tool is used to experiment with “What if” scenarios. It allows you to specify a computer account and a user account to analyze. It then allows you to manipulate where the computer account might be placed within AD and where the user account might be placed within AD. Finally, the Group Policy Modeling tool calculates the effective GPOs and their settings that configure and control the user’s session on the computer, based on their newly proposed positions within AD.

**Resultant Set of Policies (RSoP)**
Another tool that is available in Windows Vista was available in earlier operating systems. It is called the Resultant Set of Policies (RSoP) tool. This tool is still available in Windows Vista as a snap-in to the Microsoft Management Console (MMC) and must be assembled to be accessed.

Just like the Group Policy Results tool, you select which computer and which user to run the analysis on. The RSoP tool performs its analysis based on where the specified computer account actually is located within AD and where a specified user account actually is located within AD to produce the results. The Resultant Set of Policy tool is also called a “What is” analysis tool because it too is based on the objects’ actual locations in AD.

As shown in Figure 3.21, the RSoP tool presents the results like a GPO is formatted. This makes a quick overview more difficult than the summary of settings that is presented with the newer Group Policy Modeling and Group Policy Results tools inside the GPMC, and explains why this might not be your first choice of GPO analysis tools.
A third tool to perform a similar analysis is the command-line tool called GPResult.exe. This tool analyzes only the local machine where the command is executed and the user who is currently logged on to that machine. The output is ASCII text. It identifies the computer and its configuration and status on the network and also its position in AD. Then GPResult reports on all the GPOs that affect the computer. GPResult then repeats the process for the user who is logged on to the computer.
Chapter 3: Managing and Maintaining Systems That Run Windows Vista

Scheduling Tasks

Often, the best time to perform maintenance for performance and disaster recovery is late, late at night, when all the users are at home and asleep, and the servers and the network are at their quietest. The problem is that at that time of the night, all the administrators are also at home and fast asleep. So how should you get your maintenance tasks running at two o’clock in the morning? Why, the Task Scheduler is your tool to do this, of course.

The Task Scheduler is located in Control Panel > System and Maintenance > Administrative Tools. It has a new look and feel in Windows Vista, and has features and capabilities like never before.

The old Task Scheduler in Windows XP and even in Windows Server 2003 was (is) pretty basic; to use it, you followed these steps:

1. Select an executable or script to run.
2. Input credentials to run the task.
3. Set the schedule.

You were done in about three steps.

**TIP**

The Task Scheduler relies on an underlying service named (Surprise!) the Task Scheduler service. This service may have been stopped for security and performance reasons. If you plan to configure scheduled tasks, you should verify that the Task Scheduler service is started.

The new Task Scheduler has a large library of preconfigured, system-related tasks. Some tasks are active and are already performing their duties in the background. Some tasks are lying dormant, waiting for someone to set a valid trigger to activate them.

As shown in Figure 3.22, the library of preconfigured tasks covers a wide range of targets.

To make adjustments to the existing tasks, click the **Properties** hyperlink in the Actions pane on the right. This brings up the configuration details, as shown in Figure 3.23. The General tab shows which credentials are used to run the task.
FIGURE 3.22 Preconfigured Windows tasks are available in the Task Scheduler.

FIGURE 3.23 The properties of a scheduled task.

EXAM ALERT
On the Triggers tab, you can configure what causes your application to run. As you can see in Figure 3.24, you have many new options to choose from. Notice that triggers can even be generated from specified events within Event Viewer. Multiple different triggers can be included on the Triggers list.
Chapter 3: Managing and Maintaining Systems That Run Windows Vista

![Image](44x388 to 263x577)

**FIGURE 3.24** The triggers that launch a scheduled task now include At Log On and At Startup.

**EXAM ALERT**

On the Actions tab, you can configure what the Trigger event causes to happen. As you can see in Figure 3.25, you can start a program, send an email, or display a message on the console. Multiple actions can be included on the Actions list.

![Image](45x66 to 246x282)

**FIGURE 3.25** Actions now include Start a Program, Send an E-mail, or Display a Message on the Console.
A new setting on the Conditions tab is to start the task only if a specified network connection is available. The Settings tab has a new option on what to do if an instance of the task is already running. The choices include

- Do Not Start a New Instance
- Run a New Instance in Parallel
- Queue a New Instance
- Stop the Existing Instance

And finally, the History tab shows a log of activity related to this one task.

Tasks are now recorded in XML files. These XML files can be easily exported and imported onto other Windows Vista computers.

**Command-Line Task Scheduler Tools**

Surprisingly, the old AT command-line Task Scheduler tool is still around and kicking. But the recommended command-line tool to use is called SchTasks.exe. This tool isn’t new in Vista but is newer than AT.

While SchTasks can’t use triggers other than the clock, and can launch only executables and scripts, you can use SchTasks with these switches to perform the following functions regarding scheduled tasks:

- **Run**—Launches the scheduled task immediately
- **End**—Stops the currently running scheduled task
- **Query**—Displays all scheduled tasks
- **Change**—Changes the properties of the scheduled task
- **Create**—Creates a new scheduled task
- **Delete**—Deletes the scheduled task(s)

You should be familiar with these basic functions available with this command-line utility for the exam.

**Event Viewer and Event Forwarding**

Event Viewer is a tool used to monitor the health of the computer. Event Viewer has had a significant overhaul in Windows Vista and is now closely integrated with Task Scheduler and the Reliability and Performance Monitor. You can access Event Viewer in Administrative Tools and use it to perform the following functions:
Chapter 3: Managing and Maintaining Systems That Run Windows Vista

- View and filter events from a multitude of preconfigured logs.
- Create and save custom event filters and views.
- Configure tasks to run in response to specified events.
- Configure and manage event subscriptions.

The preconfigured logs fall into two categories—Windows Logs and Applications and Services Logs—as shown in Figure 3.26.

**FIGURE 3.26** The main window in Event Viewer shows the Windows Logs and Applications and Services Logs.

As you expand Applications and Services Logs > Microsoft > Windows, you discover dozens of additional, preconfigured event logs. These logs address specific services and features of the operating system and can be used to identify problems, before they start, as well as provide diagnostic and troubleshooting information after something unexpected has happened.

There are two more collections of logs available within Event Viewer:

- **Analytic Logs**—Describe program operations and indicate problems that cannot be addressed with human intervention. Analytic logs generate a high volume of output.

- **Debug Logs**—Used to help developers troubleshoot issues with their programs.

**EXAM ALERT**

These two logs are hidden by default due to their specialized nature and large volume of output. You can make them visible and functional by enabling them from the View > Show Analytic and Debug Logs menu item, as shown in Figure 3.27.
Event Forwarding

Event Forwarding is used to consolidate events from multiple computers, called Source computers, onto a single monitoring station, called the Collector computer. Event types include all the event categories in the Windows Logs and Applications and Services Logs. Both Source and Collector computers must be specially configured for Event Forwarding to be successful.

**TIP**

To configure Event Forwarding, you should log on to the Source and Collector computers using a domain administrator user account.

**Source Computer Configuration**

On the Source computers, you must configure the Windows Remote Management utility by executing the following command at an elevated privilege command prompt:

```
winrm quickconfig
```

This command makes some changes to your system, including setting the WinRM service to auto start; creates a WinRM Listener on HTTP to accept Web Services for Management (WS-Man) requests—a mini, nonuser-configurable web server); and opens the firewall for WinRM services.
You must also add the computer account of the Collector computer to the local Administrators group on each Source computer.

**NOTE**

**Finding Computers** You must enable the adding of computer accounts to the local Administrators group on each Source computer by selecting Object Type > Computers in the Select Users, Computers or Groups dialog box in the local Administrators group properties.

**Collector Computer Configuration**

On the Collector computer, you must configure the Windows Event Collector Utility by executing the following command at an elevated privilege command prompt:

```
wecutil qc
```

This command initializes the Windows Event Collector on the Collector computer. Now you are ready to create subscriptions on the Collector computer to Source computer events.

**NOTE**

**Required Services** The Windows Remote Management (WinRM) service and the Windows Event Collector Service must be started on the Source and Collector computers. By default, these services are set to start up manually. You should configure them for automatic startup to ensure proper functionality and future use of their services.

**EXAM ALERT**

Here’s a quick review:

- You must configure the Windows Remote Management utility by running `winrm` on the Source computers.
- You must configure the Windows Event Collector Utility by running `wecutil` on the Collector computer.
- You should familiarize yourself with the basic functions of these two commands by running the executables followed by the `/?` switch.

To configure subscriptions, in Event Viewer on the Collector computer, right-click **Subscriptions** in the left pane and select Create Subscription. The Subscriptions Properties page is shown in Figure 3.28.

**NOTE**

**First Things First** Subscriptions can be established only with properly configured Source computers.
FIGURE 3.28  Configuring an event subscription on the Collector computer.

By clicking **Select Events**, you see that events can be largely unfiltered to acquire large amounts of data or finely filtered to acquire only a very specific and smaller number of events. The Query Filter dialog box for the Subscription is shown in Figure 3.29.

FIGURE 3.29  Configuring a Query Filter to limit the types of events collected on the Collector computer.
The Advanced button on the Subscription Properties dialog box allows for the configuration of the account that will read the log files. This account must have permissions to access the log files and is typically the computer account that you placed in the local Administrators group on the Source computers. You can also configure the forwarded event delivery for Bandwidth or Latency optimizations.

**EXAM ALERT**

Also on the Advanced Subscription Settings dialog box, you can configure events to be forwarded using the HTTP protocol over port 80 (the default), or they can be transmitted securely using HTTPS, which is the HTTP protocol over a Secure Sockets Layer (SSL) tunnel. The HTTPS protocol runs over port 443 and requires a computer certificate to authenticate the Source computer to the Collector computer and to establish the encrypted SSL tunnel. Any firewalls between Source computers and the Collector computer require the appropriate port (80 or 443) to be opened. The User Account, Event Delivery Optimization, and transmission Protocol configuration settings are shown in Figure 3.30.

![Advanced Subscription Settings dialog box](image)

**FIGURE 3.30** Advanced Subscription Settings provides access to the User Account, Event Delivery Optimization, and transmission Protocol configuration settings.

### Reliability and Performance Monitor

Whereas Event Viewer allows you to monitor system and application events, Reliability and Performance Monitor (RPM) allows you to monitor and log the reliability and performance of your computer. This is the new, upgraded version of the old PerfMon tool that has been around since the NT days.

RPM has three monitoring tools:

- **Resource View**—Provides a quick look at CPU, disk, network, and memory utilization in real time.
Reliability and Performance Monitor

- **Performance Monitor**—Uses collections of counters (a *Data Collector Set*) to monitor and log specific resource components in real time or in written logs, for historical review and analysis.

- **Reliability Monitor**—Monitors and logs software, operating system, and hardware failures to present an overview of the system’s stability over time.

The RPM tool can be accessed in Administrative Tools. The main dialog box for RPM is shown in Figure 3.31.

![Reliability and Performance Monitor](image)

**FIGURE 3.31** The Resource Overview is presented when you open the Reliability and Performance Monitor.

### Data Collector Sets (DCSs)

The actual data collection and logging is performed by using Data Collector Sets (DCSs).

**NOTE**

**Data Collector Sets Versus Event Forwarding Collector**  
Don't confuse the Data Collector Sets in RPM with the Event Forwarding Collector computer.
You can also create your own DCSs to log any combination of performance counters available on the system. Additional performance counters may get added to the system over time as you add features and services and install applications on the computer. A sample, custom Data Collector Set is shown in Figure 3.32.

EXAM ALERT

There are several preconfigured System Data Collector Sets. They include
- LAN Diagnostics
- System Diagnostics
- System Performance
- Wireless Diagnostics

These tools provide a fast and easy way to collect information on the main system functions.

On the General tab, you can describe the details of your custom DCS and configure the credentials for running the log. On the Directory tab, you can configure where the log files are written to, as well as the format for the naming convention used for the DCS log files. The Security tab is the place where you can configure who can access and modify the DCS parameters. The Schedule tab is the place where you configure the Start conditions for the DCS. The Schedule tab is shown in Figure 3.33. You’ll notice that you can schedule the collector to run on a daily basis, and you can add multiple schedules.
The Stop Condition tab is the place where you configure what terminates the DCS. The stop condition can be an amount of time or some number of megabytes consumed by the log file. This tab is shown in Figure 3.34.

Finally, the Task tab allows you to configure an executable or script to run when the DCS stops. This integrates with the Task Scheduler to perform the launching of the specified task.
Chapter 3: Managing and Maintaining Systems That Run Windows Vista

The Performance Monitor

The Performance Monitor, shown in Figure 3.35, is a real-time display of system resources. Using the Performance Monitor, just like a DCS, you configure specific counters to monitor and display. This tool does not record any information. When the data is overwritten by the next pass of the timer mark, the data is lost forever. If you need to keep a record of the data for later review, you must use a Data Collector Set that generates a written log file.

EXAM ALERT

The output from RPM can be reviewed in the RPM tool, or it can be exported into a SQL database. This would usually be done when there is a large number of systems being logged with lots of data, and a more detailed analysis is required.

The tool to use to convert the standard log file into one compatible is an executable called ReLog.exe, included with Windows Vista. This tool allows you to adjust the counters (only for fewer counters, of course), adjust the sampling rate of the logged data (only for larger intervals, of course), and lets you change the file format into binary log files (.BLG), comma-separated value log files (.CSV), and files compatible with SQL. (.CSV files can be imported into spreadsheet applications and databases like SQL or MS Office Access.)

In general, there are four main resource targets for monitoring:

- **RAM**—Monitor Pages Per Second. This value should be less than 20 (average). If it is greater than 20, the system needs more RAM.
CPU—Monitor Percent Processor Time. This value should be less than 70–80% (average). If it is greater than 70%, add a faster CPU, add a second CPU, or move some processes to a less loaded system.

Disk Subsystem—Monitor Percent Disk Time. This value should be less than 50% (average). If it is greater than 50%, add a faster disk, add a faster disk array (RAID 0 or RAID 5), or move some accessed content to a lesser used disk.

Network Subsystem—Monitor Bytes Total per Second. This value should be less than 6MB/s (average). At 6MB/s, the NIC is occupying about 50% of a 100Mbps network. This is too much. If it is greater than 6MB/s, figure out what is sending and/or receiving over the network. You'll probably find that the problem is really that the NIC is failing and should be replaced.

The Reliability Monitor

The Reliability Monitor tracks application, operating system, and hardware failures to present a trend analysis of system stability. The Reliability Monitor is shown in Figure 3.36.

The Index rating in the upper-right corner is an indication of the reliability and stability of the system. You can select any incident on the calendar chart and review details of the incident.
Exam Prep Questions

1. You enable Auditing for Object Access, Success, and Failure in a GPO and link it to the Production OU. After you configure the System Access Control List of the targets of interest, which of the following is NOT logged as a result of this audit policy?
   - A. File access
   - B. Printer access
   - C. Registry changes
   - D. AD object access

2. You have just created a new Group Policy Object. You are considering the proper location to link the GPO to achieve your desired results. Place the following in the proper order that matches how GPOs get processed.
   - A. Site
   - B. Organizational Unit
   - C. Local Computer Policy
   - D. Domain

3. As a security measure, you configure and link a GPO that disallows the installation of USB thumb drives for computers in the Secretary's OU. One of your administrators is implementing a new wireless configuration in the secretaries department. The administrator’s automated deployment strategy includes the use of the Wireless Network Setup Wizard. The administrator's deployment fails on 100% of the computers. You need to get the secretaries’ computers running on the wireless network. You must not diminish security for the enterprise. What should you do?
   - A. Disable the Computer Configuration half of the Device Installation Restriction GPO.
   - B. Configure a GPO to allow administrators to override Device Installation Restriction policies.
   - C. Disable SSID broadcasts on the wireless access point.
   - D. Implement the MAC address filtering on the wireless access point.

4. You have a domainwide Path Rule configured to disallow the use of an application set to *\BadApp\badapp.exe. The application installs in the C:\Program Files\BadApp\ folder. Users in the R&D OU need to test a system with the
badapp.exe program, and they report that they receive an error whenever they launch badapp.exe. You must allow the use of badapp.exe in the R&D OU and not diminish the security of the company. What should you do? Choose two. Each correct answer presents a complete solution.

- **A.** Create a Software Restriction policy and link it to the R&D OU. Set the Default Rule to Allow.
- **B.** Create a Software Restriction policy and link it to the R&D OU. Set the Hash Rule to allow the hash of badapp.exe.
- **C.** Create a Software Restriction policy and link it to the R&D OU. Set the Path Rule to Allow *\badapp.exe.
- **D.** Create a Software Restriction policy and link it to the R&D OU. Set the Path Rule to Allow *\Program Files\BadApp\badapp.exe.

5. Your R&D users access highly confidential data on your HiSec Servers. All R&D users run Windows Vista on their computers. All HiSec Servers run Windows Server 2003 Standard Edition. You are concerned about sniffers on the network and must secure all data transmissions to and from the HiSec Servers. What should you do?

- **A.** Implement a Secure Server IPSec Policy on the HiSec Servers.
- **B.** Implement a Secure Server IPSec Policy on the R&D computers.
- **C.** Implement a Server Request IPSec Policy on the R&D computers.
- **D.** Implement a Client Respond IPSec Policy on the HiSec Servers.

6. Your company rotates the employees between departments (OUs) regularly for security and cross-training purposes. You have deployed an application to users in your department (OU) by GPO. Because your cost center has paid for the licenses, you need to ensure that this software is not installed on computers used by users outside your OU. What should you do?

- **A.** Require that all users log off their computers each night so that software deployment GPOs will reapply when they log in each morning.
- **B.** Disable the Software Deployment GPO setting to install the application by file extension activation.
- **C.** Implement a Software Restriction Policy with a Default Rule set to Disallowed and a Certificate Rule set to allow the application in your OU.
- **D.** Configure the Software Deployment package to uninstall the application automatically if it falls out of the scope of the GPO.
7. You convinced one of your vendors to provide you with a personal calendar application that some users might find useful. The regular price of the application is $300 per user, but you got it for $50 per user. You want to make it available to users in your OU that would like to use it. What should you do?
   - A. Publish the software package to the computer.
   - B. Assign the software package to the user.
   - C. Publish the software package to the user.
   - D. Assign the software package to the computer.

8. You plan to deploy a software package to computers in your OU. You must configure the permissions required for you to upload the package to the Software Distribution Point (SDP) and for computers to receive the package. You want the security level to remain as high as possible. What should you do? Choose two. Each correct answer presents a partial answer.
   - A. Grant the Authenticated Users group the Allow—Read permission.
   - B. Grant the Everyone group the Allow—Change permission.
   - C. Grant the Administrators group the Allow—Change permission.
   - D. Add the computer names to the Trusted Sites list in Internet Explorer.

9. You have two weekly scheduled tasks that are currently running. You need to terminate them both. GoodApp.exe needs to run again at its next scheduled time. OldApp.exe never needs to run again. What should you do? Choose two. Each correct answer presents a partial solution.
   - A. Run the command SchTasks /end for the GoodApp.exe task.
   - B. Run the command SchTasks /delete for the GoodApp.exe task.
   - C. Run the command SchTasks /end for the OldApp.exe task.
   - D. Run the command SchTasks /delete for the OldApp.exe task.

    - A. Run the winrm.exe utility on your computer.
    - B. Run the winrm.exe utility on the 10 computers.
    - C. Run the wecutil.exe utility on your computer.
    - D. Run the wecutil.exe utility on the 10 computers.
11. You work with nine other administrators in your enterprise. They all seem to create and implement GPOs at their own discretion, without any coordination. You implement a new GPO, and users report that they are not seeing the effect of the new GPO. What three tools could you use to troubleshoot this GPO problem? Choose three. Each correct answer presents a partial answer.

   A. Group Policy Management Console—Group Policy Modeling
   B. Computer Management
   C. GPUpdate.exe
   D. Resultant Set of Policies
   E. Active Directory domains and trusts
   F. Local Computer Policy
   G. GPResult.exe
   H. Remote Desktop Connection

12. You are preparing a report to management on the performance of several of the computers that you are responsible for in your company. You are deciding the best method of extracting information for analysis in a third-party program. Which of the following are available export formats for the Reliability and Performance Monitor (RPM) tool? Choose two. Each correct answer presents a partial answer.

   A. *.evt
   B. *.csv
   C. *.bin
   D. *.blg

13. You have created a scheduled task to run every night at midnight on a server using the credentials of the Administrator account. You check the logs and discover that the task has failed to run any night over the past week. You test the executable and it works just fine. You need the task to run every night. What should you do?

   A. Run the SchTasks /Run command-line utility on the server.
   B. Delete and re-create the Scheduled Task using the same parameters.
   C. Configure the task to run using your credentials.
   D. Configure the firewall on the server to allow inbound UDP port 500.
Answers to Exam Prep Questions

1. Answer D is correct. AD object access are NOT logged as a result of this audit policy. After the SACL is configured, Auditing Object Access tracks access to Files, Folders, and Printers and also tracks Registry changes. Directory Service access tracks AD object access. Both these audit policies require additional configuration of the SACL on the object(s) of interest.

2. The correct order for GPO processing is C, then, A, then D, and then B. L-S-D-OU is the way that policies get processed. The Local Computer Policy is followed by Site policies, followed by Domain policies, and finally followed by OU policies. OU policies process starting with the top-level OU policies, which are then followed by each subsequent child OU’s policies walking down the OU hierarchical branch. First, the computer half gets processed, L-S-D-OU, as the computer boots up. Then the user half gets processed, L-S-D-OU, after the user logs in. Together, these establish the desktop and security for the user’s session on that computer.

3. Answer B is correct. The wireless configuration deployment failed because of the Device Installation Restriction policy. Wireless configuration can be automated on a thumb drive. You can configure the Device Installation Restriction not to apply to Administrators. Disabling the computer half of the GPO would weaken security because it would disable the device installation restrictions. The SSID broadcasts and MAC address filtering both enhance security for the wireless network but would not facilitate the deployment of the wireless configuration to the secretaries’ computers.

4. Answers B and D are correct. The processing priority for the different rules is Certificate Rules override all other rules, followed by Hash, Path, Internet Zone, and finally the Default Rule has the lowest priority and is overridden by any other rules. So to override a Path Rule, you could implement a Hash Rule for the R&D OU, answer B. The most specific Path Rule overrides a less specific Path Rule, so the longer path in answer D would override the shorter Path Rule set at the domain level.

5. Answer A is correct. You must implement the Secure Server IPSec policy on the servers. The Secure Server IPSec policy on the Vista clients would require security only for inbound connections. In this case, the Vista computers are the clients and are making outbound connections to the HiSec Servers. The Server Request IPSec policy would allow unsecured connections if a client could not run IPSec. The client respond policy would be required on the Vista computers, not the servers.

6. Answer D is correct. The Software Deployment GPO can be configured to uninstall the software when the users are no longer within your OU. Logging off by itself does not cause the software to be removed from computers. File extension activation configures the software package for installation, not removal. Setting the Default Software Restriction Policy to Disallowed would disallow all software from running on your OU. This would not remove any software from computers being used by users outside your OU.
7. Answer C is correct. You want to publish the software to the users. This way, only the ones who want to use the application will install it. Software packages cannot be published to computers, only assigned. Even though you got a deal on the software, assigning to the users costs you extra money because all users get the package. Assigning to the computers also costs you extra money, again, because all computers get the software.

8. Answers A and C are correct. Authenticated users need the Allow—Read permission. Administrators need at least the Allow—Change permission. (Most of the time, administrators grant themselves the Allow—Full Control permission on these SDPs because they may need to make adjustments to the NTFS permissions within the share point. But this is more privilege than is required on the SDP.) Everyone Allow—Change is too much privilege, and adding the computer names to the Trusted Sites list in IE has no benefit in this scenario.

9. Answers A and D are correct. You simply want to terminate the currently running instance of GoodApp.exe but keep the task scheduled for future executions. For this, you use the /end switch. You want the currently running instance of OldApp.exe to be terminated, and you want OldApp.exe to be removed as a scheduled task, so you would use the /delete switch on the SchTasks.exe command.

10. Answers B and C are correct. You need to run the Windows Remote Management utility (winrm.exe) on the 10 remote Windows Vista computers. These are the Source computers. You want to run the Windows Event Collector utility (wecutil.exe) on the Collector computer, your one Windows Vista computer.

11. Answers A, D, and G are correct. The three tools available to analyze how GPOs are being applied are the Group Policy Modeling tool inside GPMC, the older Resultant Set of Policies (RSoP), and GPREsult.exe. The Computer Management MMC includes several worthy tools, like Local Users and Groups, Disk Management and Services, but it does not analyze GPO processing. GPUpdate reapply GPOs that have been changed since the last GPO Refresh. Used with the /Force switch, it can reapply all GPOs to a user's session, but it does not analyze GPO processing. AD domains and trusts is used to transfer the Domain Naming Operations Master and to assemble and test inter-domain and inter-forest trusts. The Local Computer Policy might be considered one of the policies being analyzed, but it does not analyze GPO processing. Remote Desktop Connection is used to make connections to Terminal Servers, and it does not analyze GPO processing.

12. Answers B and D are correct. The RPM tool can export into binary log file format (*.blg) and the comma-separated value file format (*.csv). *.evt files are used by Event Viewer as the extension for its log files. *.bin files are usually binary files, not binary log files (*.blg).

13. Answer C is correct. Because the task fails when running with the credentials of the administrator but runs successfully when it is launched using your credentials, use your credentials to launch the Scheduled Task. The SchTasks /Run command causes the task to launch immediately. Deleting and re-creating the task with the same parameters does not resolve the credentials issue. UDP port 500 is used by IPSec, which has nothing to do with this issue.
Need to Know More?

The following websites present a wealth of technical information relating to the topics presented in this chapter. When on a web page, you often can find additional hyperlinks that address related topics to help you flesh out your knowledge and understanding of the topic.

**NOTE**

The Value of TechNet  Some of these websites may require a membership to Microsoft TechNet. Microsoft TechNet is one of your most valuable collections of tools and resources available to you as a Microsoft IT Professional. If you don’t have one already, and you plan on being professionally responsible for Microsoft computers, you probably need a Microsoft TechNet membership.

1. Windows Vista Step-by-Step Guides for IT Professionals—Many topics:  

2. Group Policy processing and precedence:  

3. Slow Link detection by XP using ICMP:  
   http://support.microsoft.com/kb/816045

4. Group Policy Settings for Windows Vista:  

5. Group Policy Settings for Windows Server 2003 and Windows XP:  

6. Software deployment by GPO:  

7. Troubleshooting Software deployment GPOs:  
8. Audit Policy:

9. Software Restriction Policies:
   http://www.microsoft.com/technet/security/prodtech/windowsxp/secwinxp/xpsgch06.mspx

10. Task Scheduler:

11. Windows Vista Management Features:

12. Event Viewer:

13. Event Forwarding over the Internet:

14. Reliability and Performance Monitor:
Symbols

6to4 addresses, 224
802.11
   A/B/G wireless adapters, 210
   wireless standards, 250-251

A

Access Control Lists. See ACLs
access points (APs), 251
accessing
   ActiveX controls, 94
   Advanced Boot Options menu, 314
   encryption, 103
   GPMC MMCs, 169
   IPSec, configuring, 137-138
   Network and Sharing Center, 229
   permissions, configuring, 130-134
   potentially risky content, 89
   printers, 134-136, 296
   Protected Mode, 89
   remote access, 265
      connections, 266-270
      managing connections, 270-273
   Remote Desktop Protocol (RDP), 139-140
   Windows Security center, 100
   wireless access points, 232
   WPA, 255

accounts
   System, 88
   User Account Control (UAC), 143-146, 239

ACLs (Access Control Lists)
   printers, sharing, 136
   SACLs, 179
   security, 274-276, 278-279
ACT (Application Compatibility Toolkit) 5.0, 66, 312

Active Directory. See AD

ActiveX controls, 89
   GPOs, configuring, 182
   opt-in, 93-94

AD (Active Directory), 159
   domains, 160
   forest, 159
   GPOs, applying, 162-170
   sites, 160

Add a Wireless Device Wizard, 253

add-ons, ActiveX, 94. See also ActiveX controls

adding
   drivers, 52
   groups, 136
   printers, 134
   users, 136

Address Resolution Protocol. See ARP

addresses
   APIPA, 216-217
   DNS, configuring, 217-218
   IP, static, 241, 259
   IPv4, 212
   local-use, 228
   MAC, filtering, 258
   NAT, 214, 220
   servers, WINS, 219
   space, 222-225
   troubleshooting, 237-240
   types of, 221
   URLs, 95

Advanced Boot Options menu, 314

Advanced Security, Windows Firewall with, 111-112
alerts, Windows Security Center, 99-101
allowing connections, 281
Allow permissions, 132
Alternate DNS servers, 217
Always Trust Content From, 97

American Registry for Internet Numbers (ARIN), 221

analysis
   deployment
      BDD 2007, 28-36, 38-43
      infrastructure requirements, 32-35
      Microsoft Deployment Solution Accelerator, 29
      scenarios, 30-32
      selecting, 28
      GPRResult.exe tool, 185
      Security Configuration and Analysis Tool (SCAT), 104-107

Analytic logs, 190

answer files
   applying, 47
   formatting, 41-43
   troubleshooting, 67-68

answers
   practice exam 1, 355-366
   practice exam 2, 385-393

anycast addresses, 221

APs (access points), 251

APIPA (Automatic Private IP Addressing), 216-217

Application Compatibility Toolkit (ACT) 5.0, 312

applications
   compatibility, troubleshooting, 63-66
desktop support, 294
   deployment, 297-300
   legacy applications, 296
   maintenance, 305-312
   operating systems, troubleshooting, 313-329
   printing, 294-296
   security, 297
   software restrictions, troubleshooting, 300-304
Microsoft SpyNet, 115-117
quarantine, deleting from Windows Defender, 114
Software Restriction policies, 174-176
troubleshooting, 298
Windows Update, 120
  automatic updates, 123-124
  manual updates, 120-123
troubleshooting, 127-129
Windows Server Update Services (WSUS), 125-127

applying
  BCDedit, 59
  Bootcfg.exe, 58
custom answer files, 47
GPOs, 162-170
ImageX, 44-45
MSConfig.exe, 59
Sysprep, 43
System restore, 321
ARIN (American Registry for Internet Numbers), 221
ARP (Address Resolution Protocol), 216
ATM (Asynchronous Transfer Mode), 267
attacks, DoS, 166
audit policies, 178-180
authentication
  EAP, 268-269
  SmartCards, 142-143
  troubleshooting, 141-142
  wireless security, 259-260
Authenticode, 182
autoconfiguration
  IPv6, 240-241
  stateful address, 227
  stateless address, 227
Automatic Private IP Addressing. See APIPA
automatic updates, 123-124
availability of drivers, 52-53

B

Background Intelligent Transfer Service (BITS), 127
backups, Complete PC Backup, 322-324
BAP (Bandwidth Allocation Protocol), 267
Basic Service Set (BSS), 251
BCD (Boot Configuration Data), 49, 316-317
  managing, 57-61
BDD (Business Desktop Development) 2007, 28-29
  applying Sysprep, 43
  components, configuring, 35-36
  creating source computers, 40
  formatting answer files, 41-43
  migration, 36-40
binary log files, 198
BIOS, booting and, 317
BitLocker, 102-103
BITS (Background Intelligent Transfer Service), 127
Block Inheritance setting, 165-166
blocking connections, 281
Bluetooth Personal Area Network (PAN), 250
BOGUS OU, 171
Boot Configuration Data (BCD) files, 49, 316-317
  managing, 57-61
Bootcfg.exe, 58
booting
  BitLocker, 103
  from installation media, 317-319
  partitions, 102
  System Recovery, 319-322
Bootmgr, 49
BOOTP relay, 215
broadcasting SSIDs, 252, 258
browser security, configuring, 84-98
BSS (Basic Service Set), 251
building
  GPMC MMCs, 169
  LCPs, 158

CA (Certificate Authority), 97
caches, clearing, 98
certificates
  digital, 96-97
  GPOs, configuring, 182
  Personal Certificate Store, 104
CHAP (Challenge Authentication Protocol), 268
chips, TPM, 102
CIDR (Classless Internet Domain Routing), 217
clearing Windows Internet Explorer 7, 98
clients
  Network Discovery, 234-235
  Network Map, 233-234
  Network Setup Wizard, 233
remote access, 265
  connections, 266-270
  managing connections, 270-273
services
  configuring, 228
  Network and Sharing Center, 229-230, 235
  profiles, 230-233
  WINS, 219
CMAK (Connection Manager Administration Kit), 270
co-owner permissions, 276
code, configuring mobile, 182. See also ActiveX controls
Collector computers, configuring, 192-194
comma-separated value log files (.CSV), 198
commands
  route, 249
  route print, 249
  Undo the Convert, 330
communication, configuring LANs, 213
compatibility
  Application Compatibility Toolkit (ACT) 5.0, 312
  applications, managing, 310-312
  troubleshooting, 63-66
Complete PC Backup, 322-324
Complete PC Restore, 325-326
components, configuring BDD 2007, 35-36
Computer Management console, 277
computers
  new computer deployment scenario, 30
  refresh computer deployment scenario, 31
  replace computer deployment scenario, 31
source
  capturing images from, 44-45
  creating, 40
  upgrade computer deployment scenario, 32
configuration
  802.11 wireless standards, 250-251
  enterprise connection management, 252-257
  overview of, 251-252
  security, 258-262
  troubleshooting, 262-265
ActiveX opt-in, 93-94
AD, 159
autoconfiguration. See autoconfiguration
BCD files, 49, 316-317
  managing, 57-61
configuration

BDD 2007
  applying Sysprep, 43
  components, 35-36
  creating source computers, 40
  formatting answer files, 41-43
  migration, 36-40
Collector computers, 192-194
cookies, 92-93
DCSs, 196
digital certificates, 96-97
DNS addresses, 217-218
dual and multiboot, troubleshooting, 66-67
event subscriptions, 189
Fix Settings for Me option, 91
folders, sharing, 275-279
GPOs, 171-182
  audit policies, 178-180
  Desktop settings, 171-172
  managing devices, 176-178
  mobile code, 182
  Point and Print restrictions, 181
  software deployment, 172-174
  software restrictions, 174-176
interfaces, Netsh utility, 242
Internet Explorer 7 security, 84-98
IPSec, 137-138
LKGC, 313-315
networks
  IPv4, 212-218
  NAT, 220
  overview of, 210-211
  protocols, 211-212
  security, 273-283
  TCP/IP version 6, 220-228
  WINS, 218-219
options, 89-90
permissions, 130-134
Phishing filters, 87-88
Pop-Up Blocker, 85-86
printers, sharing, 134-136
Protected Mode, 88-90
refresh interval settings, 167
remote access, 265
  connections, 266-270
  managing connections, 270-273
Remote Desktop Protocol (RDP), 139-140
routers for DHCP relay, 216
routing, troubleshooting, 249
security
  BitLocker, 102-103
  Encrypting File System (EFS), 103-104
  Security Configuration and Analysis Tool (SCAT), 104-107
  troubleshooting, 99
  Windows Security Center, 99-101
Security Configuration and Analysis Tool (SCAT), 104-107
Security Status Bar (SSB), 94-95
services, 228
  Network and Sharing Center, 229-230, 235
  Network Discovery, 234-235
  Network Map, 233-234
  Network Setup Wizard, 233
  profiles, 230-233
SmartCards, 142-143
Source computers, 191
subscriptions, 192
trusted publisher lockdown, 182
User Account Control (UAC), 143-146
Windows Defender, 113-114
  hosts file, 118-119
  logging, 115
  Microsoft SpyNet, 115-117
  MSConfig.exe, 117
  RootkitRevealer, 119-120
Windows Event Collector Utility, 192
Windows Firewall, 107-112, 279-283
Windows Remote Management utility, 192
configuration

Windows Update, 120
  automatic updates, 123-124
  manual updates, 120-123
  troubleshooting, 127-129
Windows Server Update Services (WSUS), 125-127
wireless networks, 250
Connect to a Network dialog box, 252, 273
Connect to a Network Wizard, 256
Connection Manager Administration Kit (CMAK), 270
connections
  802.11 wireless standards, 250-251
  enterprise connection management, 252-257
  overview of, 251-252
  security, 258-262
  troubleshooting, 262-265
dial-up, 266
firewalls, 281
LANs. See LANs
Network and Sharing Center, 229-230, 235
remote access
  managing, 270-273
  troubleshooting, 266-270
Remote Desktop, 297
tools, 248
troubleshooting, 246-247
viewing, 239
wireless networks, 250
consoles, Print Management, 294-296
contributor permissions, 276
controls, ActiveX opt-in, 93-94
conversions, file systems, 327-330
cookies
  clearing, 98
  configuring, 92-93
corrupt operating system files, troubleshooting, 69-70, 313-329

.DCSV (comma-separated value log files), 198
custom images, deployment from, 45-47
  management, 50
.WIM files, 48-49
Custom Level Security Settings dialog box, 89
customization
  DCSs, 196
  Profiles, troubleshooting, 70-71

D

Data Collector Sets (DCSs), 195-198
databases, 159. See also AD
DCPromo, 159
DCs (domain controllers), 170
DCSs (Data Collector Sets), 195-198
Debug logs, 190
decryption, BitLocker, 102
Default Domain Controllers Policy, 170
Default Domain Policy, 170
default gateways, 213
Defender (Windows), configuring, 113-114
  hosts file, 118-119
  logging, 115
  Microsoft SpyNet, 115-117
  MSConfig.exe, 117
  RootkitRevealer, 119-120
Delete Browsing History dialog box, 99
deleting
  applications from Windows Defender's quarantine, 114
  browsing content, 98
Denial of Service (DoS) attacks, 166
Deny permissions, 132
deployment
  answer files, troubleshooting, 67-68
  compatibility, troubleshooting, 63-66
corrupt operating system files, troubleshooting, 69-70
from custom images, 45-47
management, 50
.WIM files, 48-49
desktop application support, 297-300
dual and multiboot configurations, troubleshooting, 66-67
images, capturing from source computers, 44-45
methods
BDD 2007, 28-43
infrastructure requirements, 32-35
Microsoft Deployment Solution Accelerator, 29
scenarios, 30-32
selecting, 28
post-installation tasks, 50
ensuring driver availability, 52-53
managing user data, 53-57
multiple operating systems, 57-61
restoring user state data, 50-52
profiles, troubleshooting, 70-71
software, 172-174
troubleshooting, 61
user state migration, 62
Windows Recovery Console, troubleshooting, 68
desktop application support, 294
deployment, 297-300
legacy applications, 296
maintenance, 305-312
operating systems, troubleshooting, 313-329
printing, 294-296
security, 297
software restrictions, troubleshooting, 300-304
Desktop settings, configuring GPOs, 171-172
devices
LLTD, 234
managing, 176-178
UFD, 45
DHCP (Dynamic Host Configuration Protocol), 214
relay, 215
restarting, 238
scope, 216
Diagnose button, 243
dial-up connections, 266
dialog boxes
Connect to a Network, 252, 273
Custom Level Security Settings, 89
Delete Browsing History, 99
File Sharing, 276
Internet Options, 85-87
Internet Protocol version 4 (TCP/IPv4) Properties, 214
Query Filter, 193
Subscription Properties, 194
System Recovery Options, 318
Windows Graphical Identification aNd Authentication (GINA), 157
digital certificates
configuring, 96-97
GPOs, configuring, 182
Digital Subscriber Line (DSL), 267
disabling
Group Policy, 254
IPv6, 227
LCPs, 168
Protected Mode, 89
disaster recovery, Task Scheduler, 186-189
discovery, wireless networks, 252
DiskPart, 48-49
DNS (domain name system), 210
addresses, configuring, 217-218
troubleshooting, 243-244
documentation, IPv6 addresses in examples within, 225
domain controllers (DCs), 170
domain name system. See DNS
domains
  Default Domain Controllers Policy, 170
  Default Domain Policy, 170
  FQDNs, 218
  member computers, 158-162
DoS (Denial of Service) attacks, 166
drivers
  availability, 52-53
  compatibility, troubleshooting, 63-66
  non-HCL, 318
Drvload utility, 52
DSL (Digital Subscriber Line), 267
dual and multiboot configurations, troubleshooting, 66-67
Dynamic Host Configuration Protocol. See DHCP

E

EAP (Extensible Authentication Protocol), 268-269
Echo Requests (ICMP), 166
editing
  GPOs, 170
  variables, 299
effective permissions, 132. See also permissions
EFI (Extensible Firmware Interface), 58, 316
EFS (Encrypting File System), 103-104, 297
employing Software Restriction policies, 302
enabling
  Group Policy, 254
  options, 89
  Protected Mode, 88
RDP, 140
System Restore, 320
TCP/IPv6, 226
Encrypting File System (EFS), 103-104, 297
encryption
  accessing, 103
  Windows BitLocker Drive Encryption, 65
  wireless security, 259-260
Enforced setting, 165-166
entering
  passphrases, 256
  UNC paths, 90
enterprise environments, managing wireless connections, 252-257
EUI (Extended Universal Identifier), 241
Event Viewer, 156, 189-194
exams
  practice exam 1
    answers, 355-366
    questions, 337-354
  practice exam 2
    answers, 385-393
    questions, 367-384
exceptions, firewalls, 109
Extended Universal Identifier (EUI), 241
Extensible Authentication Protocol (EAP), 268-269
Extensible Firmware Interface (EFI), 58, 316
Extensible Markup Language. See XML

F

FAT, converting, 327-330
File Sharing dialog box, 276
file system support, 327-330
files
  ACLs, 274-279
  answer
applying, 47
formatting, 41-43
troubleshooting, 67-68
BCD, 49
binary log, 198
hosts, 118-119
MSP, 173
MST, 173
NTFS permissions, 277
NTUSER.DAT, 157
operating systems, troubleshooting, 69-70
security, 273-274
sharing, 235
.WIM, 43, 45
deployment, 48-49
mounting, 53
ZAP, 173
filters
    MAC ID, 258
    Phishing, configuring, 87-88
    Query Filter dialog box, 193
firewalls
    with Advanced Security, 111-112
    configuring, 107-110
    profiles, 230-233
    Windows Firewall, configuring, 279-283
first-party cookies, 92
Fix Settings for Me option, configuring, 91
folders. See also files
    redirection, 54-57
    sharing, 236, 274-279
    Temporary Internet Files, 88
forest root domain, 160
formatting. See also configuration
    answer files, 41-43
    .WIM files, 43
forms data, clearing, 98
forwarding events, 189-194
FQDNs (fully qualified domain names), 218
Full Control permissions, 173
fully qualified domain names (FQDNs), 218

g

Gateways, default, 213
Generic Routing Encapsulated (GRE) tunnels, 268
global unicast addresses, 222
GPMC (Group Policy Management Console), 169, 183
GPOE (Group Policy Object Editor), 169
GPOs (Group Policy Objects), 115, 156
    applying, 162-170
    configuring, 171-182
    domain member computers, 158-162
    editing, 170
    LCPs, building, 158
    overview of, 157
    printers, deploying, 295
    Refresh, 166
    standalone computers, 157-158
    troubleshooting, 183-185
GPResult.exe tool, 185
GRE (Generic Routing Encapsulated) tunnels, 268
Group Policy, 211, 254
    application compatibility, managing, 310-312
Group Policy Management Console (GPMC), 169, 183
Group Policy Modeling tool, 184
Group Policy Object Editor (GPedit.msc), 252
Group Policy Object Editor (GPOE), 169
Group Policy Objects. See GPOs
Group Policy Results tool, 184
groups, adding, 136
handling cookies

H

handling cookies, 92-93
HCL (Hardware Compatibility List), 63, 318
history
  clearing, 98
  Delete Browsing History dialog box, 99
host file, 118-119
HTTPS (HTTP over Secure Sockets Layer), 96

I

IANA (Internet Assigned Numbers Authority), 225
ICMP (Internet Control Message Protocol), 166
ICS (Internet Connection Sharing) service, 220
ignoring Phishing filter warnings, 87
images
  compatibility, troubleshooting, 63-66
  custom
    deployment from, 45-47
    management, 50
  .WIM file deployment, 48-49
drivers, adding, 52
ImageX, applying, 44-45
Inbound connections, configuring, 281
Infrared (Ir) connectivity, 250
infrastructure
  Light Touch Infrastructure, 32
  PKI, 96
  requirements, 32-35
installation
  BDD 2007
    applying Sysprep, 43
    configuring components, 35-36
    creating source computers, 40
    formatting answer files, 41-43
    migration, 36-40
  devices, managing, 176-178
  media, booting from, 317-319
  post-installation tasks, 50
    ensuring driver availability, 52-53
    managing user data, 53-57
    multiple operating systems, 57-61
    restoring user state data, 50-52
  printers, 134
  system requirements, 32-35
Integrated Services Digital Network (ISDN), 267
interactive users, 132
interfaces
  EFI, 58, 316
  Netsh utility, configuring with, 242
  Network and Sharing Center, 229-230, 235
  networks, configuring TCP/IPv6, 226
  security, configuring, 84-98
  WMI, 64, 101
International Organization for Standardization. See ISO
Internet Assigned Numbers Authority (IANA), 225
Internet Connection Sharing (ICS) service, 220
Internet Control Message Protocol (ICMP), 166
Internet Explorer 7
  ActiveX opt-in, configuring, 93-94
  clearing, 98
cookies, configuring, 92-93
digital certificates, configuring, 96-97
  Fix Settings for Me option, configuring, 91
  Phishing filters, configuring, 87-88
  Pop-up Blocker, configuring, 85-86
  Protected Modem, configuring, 88-90
  security, configuring, 84-98
  Security Status Bar (SSB), configuring, 94-95
LSP (Local Security Policy)

Internet Options dialog box, 85, 87
Internet Protocol version 4 (TCP/IPv4)
  Properties dialog box, 214
Intra-Site Automatic Tunnel Addressing Protocol (ISATAP), 225
IP (Internet Protocol) addresses, static, 241, 259
IP Security. See IPSec
ipconfig.exe tool, 240
IPSec (IP Security), 267, 269-270
  configuring, 137-138
IPv4 (Internet Protocol version 4)
  addresses, troubleshooting, 224, 237-240
  configuring, 212-218
IPv6 (Internet Protocol version 6)
  addresses
    space, 222-225
    troubleshooting, 237-240
    autoconfiguration, 240-241
    disabling, 227
Ir (Infrared) connectivity, 250
ISATAP (Intra-Site Automatic Tunnel Addressing Protocol), 225
ISDN (Integrated Services Digital Network), 267
ISO (International Organization for Standardization), 96
J–K–L
  keys, public key infrastructure (PKI), 96
L-S-D-OU-OU-OU, 159-162, 167
L2TP (Layer 2 Tunneling Protocol), 267-270
LANs (local area networks), 210
  Diagnostics, 196
  IPSec, configuring, 137-138
  protocols
    configuring, 211-212
    IPv4, 212-218
  NAT, 220
  TCP/IP version 6, 220-228
  WINS, 218-219
Last Known Good Configuration (LKGC), 313-315
Layer 2 Tunneling Protocol (L2TP), 267-270
LCP (Local Computer Policy), 84, 156
  building, 158
  disabling, 168
  standalone computers, 157-158
legacy applications, managing, 296
Light Touch Infrastructure, 32
Link-Layer Topology Discovery (LLTD) protocol, 234
link-local IPv6 addresses, 223
linking GPOs, 170
LKGC (Last Known Good Configuration), 313-315
LLTD (Link-Layer Topology Discovery) protocol, 234
LoadState, 38, 50
local area networks. See LANs
Local Computer Policy (LCP), 84, 156
  building, 158
  disabling, 168
  standalone computers, 157-158
local LANs, configuring IPSec, 137-138
Local Security Policy (LSP), 142
local-use addresses, 228
logs
  Analytic, 190
  Debug, 190
  Windows Defender, 115
  Windows Firewall, configuring, 282
loopbacks, 167
  addresses, 225
  Replace mode, 168
LSP (Local Security Policy), 142
MAC ID filtering, 258

Machine Out-of-Box-Experience (OOBE), 43

maintenance
  desktop applications, 305-312
  Task Scheduler, 186-189

malicious mobile code, 89

malware
  Complete PC Restore, 325-326
  exposure, minimizing, 90
  SFC, 326-327
  Windows Defender
    configuring, 113-114
    hosts file, 118-119
    logging, 115
    Microsoft SpyNet, 115-117
    MSConfig.exe, 117
    RootkitRevealer, 119-120

management
  Application Compatibility Toolkit (ACT) 5.0, 312
  BCD files, 57-58, 60-61
  BDD 2007, 28-29
    applying Sysprep, 43
    configuring components, 35-36
    creating source computers, 40-43
    migration, 36-40
  Bootmgr, 49
  Computer Management console, 277
  devices, configuring, 176-178
  Event Viewer, 189-194
  file systems, 327-330
  GPMC, 183
  images, 50
  legacy applications, 296
  Microsoft Office Compatibility Pack, 305-306
  multiple operating systems, 57-61
  Network and Sharing Center, 229-230, 235
  objects, AD, 159
  printing, 294-296
  remote access, 265-273
  Task Scheduler, 186-189
  user data, 53-57
  Windows Task Manager, 247
  wireless connectivity, 252-257
  WMI interface, 101

manual updates, 120-123

mapping, Network Maps, 233-234

Master Boot Record (MBR), 66-67

Master File Table (MFT), 328

MBR (Master Boot Record), 66-67

media, sharing, 236

memory, RAM, 157

menus, Advanced Boot Options, 314

methods, deployment
  BDD 2007, 28-43
  infrastructure requirements, 32-35
  Microsoft Deployment Solution Accelerator, 29
  scenarios, 30-32
  selecting, 28

MFT (Master File Table), 328

Microsoft Deployment Solution Accelerator, 29

Microsoft Hardware Compatibility List, 318

Microsoft Installer (MSI), 173

Microsoft Management Console. See MMC

Microsoft Office Compatibility Pack, 305-306

Microsoft Patch (MSP) file, 173

Microsoft Point-to-Point Encryption (MPPE), 268-269

Microsoft SpyNet program, 115-117

Microsoft Transform (MST) file, 173
migration
  BDD 2007, 36, 38-40
  user state, troubleshooting, 62
  USMT, 37-40
MMC (Microsoft Management Console),
  104, 157
  LCPs, building, 158
  services, viewing, 238
mobile code, 93. See also ActiveX
  configuring, 182
  GPOs, configuring, 182
modes, configuring Protected Mode,
  88-90
modifying Software Restriction Policy rules, 175
monitoring
  Performance Monitor, 198-199
  Reliability Monitor, 199
  RPM, 194-199
  Software Restriction policies, 302-304
  Windows Security Center, 99-101
monitoring, 194. See also tools
mounting .WIM files, 53
MPPE (Microsoft Point-to-Point Encryption), 268-269
MS-CHAPv2, 269
MSConfig.exe, 59, 117
MSI (Microsoft Installer), 173
MSP (Microsoft Patch) file, 173
MST (Microsoft Transform) file, 173
multiboot configurations, troubleshooting,
  66-67
multicast addresses, 221-223
multiple operating systems, managing,
  57-61

n
naming
  DNS, troubleshooting, 243-244
  FQDNs, 218
  NetBIOS, 218, 244-245
  WINs, 218-219
NAT (Network Address Translation),
  214, 220
navigating Internet Explorer 7 security,
  84-98
Nbtstat utility, 245
NetBIOS, 210
  names, 218
  troubleshooting, 244-245
Netsh utility, 242
Netstat.exe, 246-247
Network Address Translation. See NAT
Network and Sharing Center, 229-230, 235
Network Diagnostics Framework, 243
Network Discovery, 234-235
Network Location Awareness (NLA) service, 166, 232
Network Map, 233-234
Network Setup Wizard, 233
networks
  802.11 wireless standards, 250-251
  enterprise connection management, 252-257
  overview of, 251-252
  security, 258-262
  troubleshooting, 262-265
  connections, troubleshooting, 246-247
  DNS, troubleshooting, 243-244
  infrastructure requirements, 34-35
  NetBIOS, troubleshooting, 244-245
  older utilities, troubleshooting with, 248
  overview of, 210-211
protocols
  configuring, 211-212
  IPv4, 212-218
  NAT, 220
  TCP/IP version 6, 220-228
  WINS, 218-219
networks

routing, troubleshooting, 249
security, configuring, 273-283
services, 228
  Network and Sharing Center, 229-230, 235
  Network Discovery, 234-235
  Network Map, 233-234
  Network Setup Wizard, 233
  profiles, 230-233
TCP/IP, troubleshooting, 237-242
wireless, 250

new computer deployment scenario, 30
NLA (Network Location Awareness) service, 232
non-HCL drivers, 318
NT LAN Manager (NTLM) services, 219
NTFS, converting, 327-330
NTLM (NT LAN Manager) services, 219
NTUSER.DAT file, 157

objects
AD, managing, 159
GPOs, 156
  applying, 162-170
  building LCPs, 158
  configuring, 171-182
  deploying, 295
  domain member computers, 158-162
  editing, 170
  overview of, 157
  standalone computers, 157-158
  troubleshooting, 183-185

older utilities, troubleshooting with, 248
OOBE (Machine Out-of-Box-Experience), 43

operating systems
  BitLocker, 102-103
  Complete PC Backup, 322-324
  legacy application support, 296
  multiple, managing, 57-61
  troubleshooting, 69-70, 313-329

options
  BCDedit, 59
  configuring, 89-90
  Fix Settings for Me, configuring, 91
  Internet Options dialog box, 87
  LoadState, 50
  Nbtstat utility, 245
  Netstat.exe, 246-247
  ScanState, 39
  SFC, 69
  Startup and Recovery, 58

Oscdimg tool, 44
OUs (Organizational Units), 161
Outbound connections, configuring, 281

P

Package Manager, 53
packages, MSI, 173
packets, ICMP Echo Request, 166
PAN (Personal Area Network), 250
PAP (Password Authentication Protocol), 268
partitions
  boot, 102
  Diskpart, 48-49
passphrases, entering, 256
Password Authentication Protocol (PAP), 268
passwords
  BitLocker, 103
  clearing, 98
  policies, 160
patches, Windows Update, 120
Path Rules, wildcards and, 176
PathPING utility, 248
paths, 90
PC/AT BIOS, 316
PCA (Program Compatibility Assistant), 312
PEimg utility, 52
performance
desktop application maintenance, 305-312
Event Viewer, 189-194
RPM, 194-199
Task Scheduler, 186-189
Performance Monitor, 198-199
permissions
configuring, 130-134
Full Control, 173
NTFS, 277
printers, 136, 279
results, calculating, 275
troubleshooting, 124
types of, 276
User Account Control (UAC), 143-146
persistent cookies, 92. See also cookies
Personal Area Network (PAN), 250
Personal Certificate Store, 104
Personal Identification Number (PIN), 142
Phishing filters, configuring, 87-88
PIN (Personal Identification Number), 142
PING utility, 248
PKI (Public Key Infrastructure), 96
Point and Print restrictions, 181
Point-to-Point Protocol (PPP), 266
Point-to-Point Protocol over Ethernet (PPPoE), 267
Point-to-Point Tunneling Protocol (PPTP), 267-269
policies
audit, 178, 180
Default Domain Controllers Policy, 170
Default Domain Policy, 170
GPMC, 183
GPOs, 156
applying, 162-170
building LCPs, 158
configuring, 171-182
deploying, 295
domain member computers, 158-162
editing, 170
overview of, 157
standalone computers, 157-158
troubleshooting, 183-185
Group Policy, 211, 254
managing application compatibility, 310-312
LCPs, 156-158
building, 158
disabling, 168
standalone computers, 157-158
Local Computer Policy, 84
LSPs, 142
passwords, 160
Software Restriction employing, 302
monitoring, 302-304
reviewing, 300
Software Restrictions, 174-176
System Policies, 158
Pop-Up Blocker, configuring, 85-86
post-installation tasks, 50
ensuring driver availability, 52-53
managing user data, 53-57
multiple operating systems, 57-61
user state data, restoring, 50, 52
PPP (Point-to-Point Protocol), 266
PPPoE (Point-to-Point Protocol over Ethernet), 267
PPTP (Point-to-Point Tunneling Protocol), 267-269
practice exam 1
   answers, 355-366
   questions, 337-354
practice exam 2
   answers, 385-393
   questions, 367-384
Preshared Key (PSK), 259
Print Management console, 294-296
printers
   ACLs, 274-279
   permissions, 279
   security, 273-274
   sharing, 134-136, 236
printing
   managing, 294-296
   Point and Print restrictions, 181
Private IP addressing, 214
privileges, User Account Control (UAC), 143-146
profiles
   configuring, 230-233
   managing, 54
   troubleshooting, 70-71
Program Compatibility Assistant (PCA), 312
properties
   TCP/IP IPv4, configuring, 214
   Windows Firewall, 280
Protected Mode, configuring, 88-90
protocols
   ARP, 216
   BAP, 267
   CHAP, 268
   DHCP, 214, 238
   EAP, 268-269
   ICMP, 166
   ISATAP, 225
   L2TP, 267-270
   LLTD, 234
   networks
      configuring, 211-212
      IPv4, 212-218
      NAT, 220
      TCP/IP version 6, 220-228
      WINS, 218-219
   PAP, 268
   PPTP, 267-269
   RDP, 139-140
   relay, 215
   SLIP, 266
   SMB, 65
   TCP/IP, 237-242
   V.92, 266
PSK (Preshared Key), 259
public folders, sharing, 236, 274-275
Public IP addressing, 214
Public Key Infrastructure (PKI), 96
published applications, troubleshooting, 298

Q–R

quarantines, Windows Defender, 114
Query Filter dialog box, 193
questions
   practice exam 1, 337-354
   practice exam 2, 367-384

RAM (random access memory), 157
ranges, addresses, 213
RDP (Remote Desktop Protocol), configuring, 139-140
reader permissions, 276
real-time protection, 113-115
recovery. See also troubleshooting
   BitLocker, 103
   operating systems, troubleshooting, 313-329
   services, 117
Startup and Recovery option, 58
System Recovery, 319-322
Task Scheduler, 186-189
Windows Recovery Console, 68
redirection, folders, 54-57
refresh computer deployment scenario, 31
refreshing, GPO Refresh, 166
RegEdit, 315
RegEdit32, 315
Registry, IPv6, disabling, 227
Registry Editor tool, 315
relay, 215
Reliability and Performance Monitor (RPM), 156, 194-199
Reliability Monitor, 199
Relog.exe, 198
remote access, 265
connections, 266-268, 270
managing connections, 270-271, 273
Remote Desktop connections, 297
Remote Desktop Protocol (RDP), configuring, 139-140
replace computer deployment scenario, 31
reports, Windows Vista Hardware Assessment tool, 65
Request For Comments. See RFCs
requests, WS-MAN, 191
requirements, infrastructure, 32-35
resetting security, 91
resolution
DNS, troubleshooting, 243-244
NetBIOS, troubleshooting, 244-245
resources
IPSec, configuring, 137-138
permissions, configuring, 130-134
printers, sharing, 134-136
Remote Desktop Protocol (RDP), 139-140
restarting DHCP, 238
restore points, 319
restoring
Complete PC Restore, 325-326
user state data, 50-52
restrictions
Authenticode, 182
Point and Print, 181
software, 174-176, 300-304
Resultant Set of Policies (RSoP) tool, 184
reviewing Software Restriction policies, 300
RFCs (Request For Comments), 215
RFC-3849, 225
RFC-3879, 223
rights, User Account Control (UAC), 143-146
RootkitRevealer, 119-120
route command, 249
route print command, 249
routers, configuring DHCP relay, 216
rounting
CIDR, 217
IPv4 addresses, 213
troubleshooting, 249
RPM (Reliability and Performance Monitor), 156, 194-199
RsoP (Resultant Set of Policies) tool, 184
rules
Path Rules, wildcards and, 176
Software Restriction, 175
SACLs (Security Access Control Lists), 179
Safe Mode, 314-316
saved passwords, clearing, 98
scanning Windows Defender, 113-114
ScanState, 38
scenarios, deployment, 30
new computer, 30
refresh computer, 31
replace computer, 31
upgrade computer, 32
scope, DHCP, 216
SDP (Software Distribution Point), 173
Secure Set Identifier (SSID), 251, 258
Secure Sockets Layer (SSL), 194, 297
security
ACLs, 274-279
authentication
SmartCards, 142-143
troubleshooting, 141-142
BitLocker, 102-103
desktop application support, 297
DoS attacks, 166
Encrypting File System (EFS), 103-104
file and printer share, 273-274
Internet Explorer 7, 84-98
Internet Options dialog box, 86
IPSec, 137-138, 267-270
networks, configuring, 273-283
printers, sharing, 136
Remote Desktop Protocol (RDP), 139-140
resetting, 91
Security Configuration and Analysis Tool (SCAT), 104-107
troubleshooting, 99
User Account Control (UAC), 143-146
Windows Defender
configuring, 113-114
hosts file, 118-119
logging, 115
Microsoft SpyNet, 115-117
MSConfig.exe, 117
RootkitRevealer, 119-120
Windows Firewall
configuring, 107-110, 279-283
with Advanced Security, 111-112
Windows Security Center, 99-101
Windows Update, 120
automatic updates, 123-124
manual updates, 120-123
troubleshooting, 127-129
Windows Server Update Services (WSUS), 125-127
wireless networks, 258-262
Security Access Control Lists (SACLs), 179
Security Configuration and Analysis Tool (SCAT), 104-107
security identifier (SID), 43, 185
Security Status Bar (SSB), 94-95
selecting
deployment
BDD 2007, 28-43
infrastructure requirements, 32-35
Microsoft Deployment Solution Accelerator, 29
scenarios, 30-32
Window Vista editions, 33
Serial Line Internet Protocol (SLIP), 266
server message block (SMB) protocol, 65
servers
addresses, WINS, 219
relay, 215
Windows Server Update Services (WSUS), 125-127
services
configuring, 228
ICS, 220
Network and Sharing Center, 229-230, 235
Network Location Awareness, 166
networks
Network Discovery, 234-235
Network Map, 233-234
Network Setup Wizard, 233
profiles, 230-233
NLA, 232
NTLM, 219
recovery, 117
viewing, 238
Windows Server Update Services (WSUS), 125-127
WinRM, 192
WINS, 218-219
sessions, 92. See also cookies

Set Up a Wireless Router or Access Point Wizard, 253

Setup.exe, 46

SFC (System File Checker) tool, 69, 326-327

sharing
files, 235
folders, configuring, 275-279
media, 236
printers, 134-136, 236
public folders, 236, 275
security, 273-274

SID (security identifier), 43, 185

site-local addresses, 223

SLIP (Serial Line Internet Protocol), 266

Slow Link Detection setting, 165-166

small office/home office (SOHO), 65, 220

SmartCards, 102
   troubleshooting, 142-143

SMB (server message block) protocol, 65

software
   deployment, 172-174
   restrictions
      GPOs, configuring, 174-176
      troubleshooting, 300-304

Software Distribution Point (SDP), 173

Software Explorer tool, 115

SOHO (small office/home office), 65, 220


source computers
   configuring, 191
   creating, 40
   images, capturing from, 44-45

space, address, 222-225

special IPv6 addresses, 224

SpyNet (Microsoft), 115-117

spyware
   Complete PC Restore, 325-326
   Windows Defender
      configuring, 113-114
      hosts file, 118-119
      logging, 115
   Microsoft SpyNet, 115-117
   MSConfig.exe, 117
   RootkitRevealer, 119-120

SSB (Security Status Bar), 94-95

SSID (Secure Set Identifier), 251, 258

SSL (Secure Sockets Layer), 194, 297

standalone computers, 157-158

standards, 210, 250-251

Startup and Recovery option, 58

state
   user data, restoring, 50-52
   user migration, troubleshooting, 62

stateful addresses autoconfiguration, 227

stateless addresses autoconfiguration, 227

static IP addressing, 241, 259

Stop Condition tab, 197

storage, BitLocker, 102-103

stores, managing BCD, 58

Subscription Properties dialog box, 194

subscriptions
   configuring, 192
   events, 189

support
   desktop applications, 294
      deployment, 297-300
   legacy applications, 296
   maintenance, 305-312
   operating systems, 313-329
   printing, 294-296
   security, 297
   software restrictions, 300-304
   file systems, 327-330
switchen, BCDedit, 317
synchronization, time, 127
Sysprep, applying, 43
System account, 88
System Configuration Utility. See MSConfig.exe
System Diagnostics, 196
system failures, tracking, 199
System File Checker (SFC) tool, 69, 326-327
System Performance, 196
System Policies, 158
System Policy Editor, 158
system recovery, 313-329
System Recovery Options dialog box, 318
system requirements, 32-35
system variables, editing, 299

Task Scheduler, 156
TCP/IP (Transmission Control Protocol/Internet Protocol), 212
configuring, 212-218
troubleshooting, 237-242
version 6, configuring, 220-228
Temporary Internet Files folder, 88
temporary IPv6 addresses, 241
Teredo specification, 241
testing GPOs, 171
third-part cookies, 92
time synchronization, 127
tools
ACT version 5.0, 66, 312
BCD, 316-317
BCDedit, 59
BDD 2007, 28-29
applying Sysprep, 43
configuring components, 35-36
creating source computers, 40
formatting answer files, 41-43
migration, 36-40
BitLocker, 102-103
Bootcfg.exe, 58
Bootmgr, 49
Complete PC Backup, 322-324
Complete PC Restore, 325-326
DiskPart, 48-49
Drvload, 52
Encrypting File System (EFS), 103-104
Event Viewer, 189-194
GPMC, 183
GPOE, 169
GPResult.exe, 185
Group Policy Modeling, 184
Group Policy Results, 184
installation media, booting from, 317-319
ipconfig.exe, 240
LKGC, 313-315
LoadState, 38, 50
Loopback, 167
Microsoft Deployment Solution Accelerator, 29
Microsoft Office Compatibility Pack, 305-306
MSConfig.exe, 59
Nbtstat, 245
Netsh utility, 242
Netstat.exe, 246-247
Oscdimg, 44
PathPING utility, 248
PEimg, 52
Performance Monitor, 198-199
PING utility, 248
RegEdit, 315
RegEdt32, 315
Registry Editor, 315
Reliability Monitor, 199
RPM, 194-195, 197-199
RSoP, 184
Safe Mode, 314, 316
ScanState, 38
Security Configuration and Analysis Tool (SCAT), 104-107
SFC, 69, 326-327
Software Explorer, 115
System Policy Editor, 158
System Recovery, 319-322
Task Scheduler, 186-187, 189
Tracert utility, 248
troubleshooting, 248
USMT, 37-40
Windows Event Collector Utility, 192
Windows Firewall, 107-110
with Advanced Security, 111-112
Windows Remote Management utility, 192
Windows Security Center, 99-101
Windows Task Manager, 247
Windows Update, 120
automatic updates, 123-124
manual updates, 120-123
troubleshooting, 127-129
Windows Server Update Services (WSUS), 125-127
Windows Vista Hardware Assessment, 64
Windows Vista Upgrade Advisor, 64

TPM (Trusted Platform Module), 65, 102
Tracert utility, 248

tracking
cookies, 92-93
system failures, 199

traffic, configuring Remote Desktop Protocol (RDP), 139-140
Transmission Control Protocol/Internet Protocol. See TCP/IP
troubleshooting
802.11 wireless standards, 250-251
enterprise connection management, 252-257
overview of, 251-252
security, 258-262
applications, 298
authentication, 141-143
Complete PC Backup, 322-324
Complete PC Restore, 325-326
connections, 246-247
deployment, 61
answer files, 67-68
compatibility, 63-66
corrupt operating system files, 69-70
dual and multiboot configurations, 66-67
profiles, 70-71
user state migration, 62
Windows Recovery Console, 68
desktop application maintenance, 305-312
DNS, 243-244
GPOs, 183-185
Internet Explorer 7 security, 84-98
IPSec, 137-138
LKGC, 313-315
NetBIOS, 244-245
networks
IPv4, 212-218
NAT, 220
overview of, 210-211
protocols, 211-212
TCP/IP version 6, 220-228
WINS, 218-219
operating systems, 313-329
permissions, 124, 130-134
printers, sharing, 134-136
published applications, 298
remote access, 265
connections, 266-270
managing connections, 270-273
Remote Desktop Protocol (RDP), 139-140
routing, 249
RPM, 194-199
Safe Mode, 314-316
security, 99
  BitLocker, 102-103
  Encrypting File System (EFS), 103-104
  Security Configuration and Analysis Tool (SCAT), 104-107
Windows Security Center, 99-101
services, 228
  Network and Sharing Center, 229-230, 235
  Network Discovery, 234-235
  Network Map, 233-234
  Network Setup Wizard, 233
profiles, 230-233
SFC, 326-327
software restrictions, 300-304
system failures, 199
System Recovery, 319-322
Task Scheduler, 186-189
TCP/IP, 237-242
User Account Control (UAC), 143-146
Windows Defender
  configuring, 113-114
  hosts file, 118-119
  logging, 115
  Microsoft SpyNet, 115-117
  MSConfig.exe, 117
  RootkitRevealer, 119-120
Windows Task Manager, 247
Windows Update, 120-129
  automatic updates, 123-124
  manual updates, 120-123
Windows Server Update Services (WSUS), 125-127
  applying Sysprep, 43
  configuring components, 35-36
  creating source computers, 40
  formatting answer files, 41-43
  migration, 36-40

trusted publisher lockdown, configuring, 182
Trusted Root Certification Authorities, 97

trusted Sites lists, entering UNC paths, 90
tunnels, GRE, 268
Turn Off Program Compatibility Wizard, 312
turning off application compatibility engines, 312
two-factor authentication, 142
types
  of cookies, 92
  of IPv6 addresses, 221
  of permissions, 276
  of profiles, 231

U

UAC (User Account Control), 143-146, 239
UFD (USB flash drive) devices, 45
UNC (Universal Naming Convention) paths, 90
Undo the Convert command, 330
unicast addresses, 221
uniform resource locators. See URLs
unique-local IPv6 unicast addresses, 223
Universal Naming Convention (UNC) paths, 90
Universal Serial Bus. See USB
Unnamed Networks, 252
upgrading, Windows Update, 120
  automatic updates, 123-124
  manual updates, 120-123
  troubleshooting, 127, 129
Windows Server Update Services (WSUS), 125-127

upgrading
BDD 2007
  applying Sysprep, 43
  configuring components, 35-36
  creating source computers, 40
  formatting answer files, 41-43
  migration, 36-40
Windows Internet Explorer 7

computer deployment scenario, 32
LKGC, 315
Windows Vista Upgrade Advisor, 64
URLs (uniform resource locators), 95
USB (Universal Serial Bus), 102
USB flash drive (UFD) devices, 45
User Account Control. See UAC users
  adding, 136
  interactive, 132
  managing, 53-57
  profiles, troubleshooting, 70-71
  state
    data, restoring, 50-52
    migration, troubleshooting, 62
  variables, editing, 299
USMT (Windows User State Migration Tool), 37-40

V
V.92 protocol, 266
variable length subnet masking (VLSM), 220
variables, editing, 299
versions, system requirements, 32-35
viewing
  certificates, 97
  connections, 239
  Event Viewer, 189-194
  firewall logs, 282
  services, 238
virtual machines. See VMs
Virtual PC 2007, 297
Virtual Private Networks. See VPNs
viruses, Complete PC Restore, 325-326
VLSM (variable length subnet masking), 220
VMs (virtual machines), legacy application support, 296
Volume Shadow Copy Service (VSS), 323
VPN (Virtual Private Network), 267, 297
  CMAK, connecting with, 271
VSS (Volume Shadow Copy Service), 323

W
warnings, ignoring Phishing filters, 87
WCN (Windows Connect Now), 252
WDDM (Windows Vista Display Driver Model), 66
Web Services for Management (WS-Man), 191
websites
  Phishing filter warnings, ignoring, 87
  Security Status bar (SSB), 95
WEP (Wired Equivalency Privacy), 259
Wi-Fi Protected Access (WPA), 255, 259
wildcards, Path Rules, 176
.WIM (Windows Imaging) files, 43-45
  deployment, 48-49
  mounting, 53
Windows BitLocker Drive Encryption, 65
Windows Connect Now (WCN), 252
Windows Defender, configuring, 113-114
  hosts file, 118-119
  logging, 115
  Microsoft SpyNet, 115-117
  MSConfig.exe, 117
  RootkitRevealer, 119-120
Windows Event Collector Utility, 192
Windows Firewall, 107-110
  with Advanced Security, 111-112
  configuring, 279-283
Windows Graphical Identification and Authentication (GINA) dialog box, 157
Windows Imaging files. See .WIM files
Windows Internet Explorer 7
  ActiveX opt-in, configuring, 93-94
  clearing, 98
  cookies, configuring, 92-93
  digital certificates, configuring, 96-97
Fix Settings for Me option, configuring, 91
Phishing filters, configuring, 87-88
Pop-Blocker, configuring, 85-86
Protected Mode, configuring, 88-90
security, configuring, 84-98
Security Status Bar (SSB), configuring, 94-95

Windows Internet Naming Service. See WINS

Windows Management Instrumentation Interface (WMI), 64, 101

Windows PE 2.0, 44
Windows Portable Device (WPD), 254
Windows Recovery Console, 68
Windows Remote Management (WinRM) service, 192
Windows Remote Management utility, 192
Windows Security Center, 99-101
Windows Server 2003 TechCenter Library, 279
Windows Server Update Services (WSUS), 125-127

Windows System Image Manager (Windows SIM), 41
Windows Task Manager, 247
Windows Update, 120
automatic updates, 123-124
manual updates, 120-123
troubleshooting, 127-129
Windows Server Update Services (WSUS), 125-127

Windows User State Migration Tool (USMT), 37-40

Windows Vista Display Driver Model (WDDM), 66
Windows Vista Hardware Assessment tool, 64
Windows Vista Upgrade Advisor, 64
WinRM (Windows Remote Management) service, 192
WINS (Windows Internet Naming Service), 218-219

Wired Equivalency Privacy (WEP), 259
wireless access points, 232
Wireless Diagnostics, 196
wireless local area networks. See WLANs
wireless networks, 250-251
enterprise connection management, 252-257
overview of, 251-252
security, 258-262
troubleshooting, 262-265

Wizards
Add a Wireless Device Wizard, 253
Connect to a Network, 256
Network Setup Wizard, 233
Set Up a Wireless Router or Access Point Wizard, 253
Turn Off Program Compatibility Wizard, 312

WLANs (wireless local area networks), 210

WMI (Windows Management Instrumentation Interface), 64, 101

worms, Complete PC Restore, 325-326
WPA (Wi-Fi Protected Access), 255, 259
WPD (Windows Portable Device), 254
WS-MAN (Web Services for Management), 191
WSUS (Windows Server Update Services), 125-127

XML (Extensible Markup Language), 41, 47

ZAP files, 173
ZIP codes, 212
Zone IDs, 228